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Introduction
This document tells you how to create applications that look right, behave properly, and fit into the GNOME user in-
terface as a whole. It is written for interface designers, graphic artists and software developers who will be creating
software for the GNOME environment. Both specific advice on making effective use of interface elements, and the
philosophy and general design principles behind the GNOME interface are covered.

These guidelines are meant to help you write applications that are easy to use and consistent with the GNOME desk-
top. Following thse guidelines will have many benefits:

• Users will learn to use your program faster, because interface elements will look and behave the way they are
used to.

• Novice and advanced users alike will be able accomplish tasks quickly and easily, because the interface won't be
confusing or make things difficult.

• Your application will have an attractive look that fits in with the rest of the desktop.

• Your application will continue to look good when users change desktop themes, fonts and colors.

• Your application will be accessible to all users, including those with disabilities or special needs.

To help you achieve these goals, these guidelines will cover basic interface elements, how to use them and put them
together effectively, and how to make your application integrate well with the desktop.

The recommendations here build on design aspects that have worked well in other systems, including Mac OS, Win-
dows, Java and KDE. At the same time they retain a uniquely GNOME flavor.

xii



Chapter 1. Usability Principles
This section explains some of the basic principles behind the more specific technical guidelines recommended in
this document. We believe that these principles are important for all application development.

1. Design for People
Remember that the purpose of any software application is to enable some group of people to accomplish a specific
set of tasks. So, the first things to establish when designing your application are:

• who your users are

• what you want to enable them to do

For example, you may be designing an application that will enable engineers (software, electrical, or mechanical) to
create diagrams. You may be designing an application that will enable system administrators to configure and moni-
tor a web server. You may be designing an application that will help elementary school students to learn math.

The important thing is that you know your audience, and you understand both their goals and the tasks necessary to
achieve those goals. There are a large number of professional interaction designers who write books and teach
courses on design methods that can help with this process, many of which are extremely useful. Most of these meth-
ods, however, boil down to specific ways of understanding your users, understanding the tasks you want to help
them accomplish, and finding ways to support those tasks in your application.

2. Don't Limit Your User Base
If you are designing an application for use by engineers, or by children, or by system administrators, be sure to cre-
ate an application that can be used by all engineers, children, or system administrators, including those with disabili-
ties or those who are native speakers of a language different from yours. Be aware of accessibility issues and inter-
nationalization and localization issues, many of which are addressed by the guidelines in this document.

2.1. Accessibility

Accessibility means enabling people with disabilities of some kind to participate in life's activities: in this case,
specifically to use your software. For example:

• Color-blind users may not be able to use your application if you rely only on color-coding to distinguish differ-
ent types of information

• Users with hearing impairments may not be able to use your application if you rely on sounds to indicate critical
information

• Users with limited movement may not be able to use your application if you don't provide keyboard equivalents
for commands

Your software should also be usable with voice interfaces, screen readers such as gnopernicus
[http://developer.gnome.org/projects/gap/AT/Gnopernicus/index.html], alternate input devices, and other assistive
technologies. The standard GNOME libraries do most of this work for you, but with a little extra effort you can
make your application every bit as useful to users who rely on those technologies as to those who don't.

More information on accessibility in GNOME can be found at the GNOME Accessibility Project
[http://developer.gnome.org/projects/gap/].
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2.2. Internationalization and Localization

Internationalization is designing software so that it can function in different language environments. Localization is
the process of actually translating the messages, labels, and other interface elements of an application into another
language.

GNOME has excellent support for both internationalization (also referred to as i18n) and localization (also referred
to as L10n). In most cases, simply using standard GNOME APIs for displaying text and messages will allow you or
others to localize your application for other locales. For more information on how to make your application localiz-
able, see the Pango project home page [http://www.pango.org] (Pango is the GNOME library for rendering interna-
tionalized text), the GNOME Translations page [http://www.gnome.org/i18n/], and the GNOME Translation Project
page [http://developer.gnome.org/projects/gtp/].

3. Create a Match Between Your Application and the Real
World

Always use words, phrases, and concepts that are familiar to the user rather than terms from the underlying system.
Use terms that relate to the user's knowledge of the tasks your application supports. For example, in medicine, the
paper folder that contains all information about a specific patient is called a "chart." Hence, a medical application
might refer to a patient record that contains the same information as a paper chart as a "patient chart" rather than as a
"patient database record."

You can often take advantage of your users' knowledge of the real world by using metaphor— that is, a familiar
concept from the outside world— to represent elements within your application. For example:

• an image of a file folder suggests a container into which documents can be placed

• a waste basket suggests a container into which items can be placed when they are no longer needed

When using metaphors, however, it is important to neither take the metaphor too literally, nor to extend the
metaphor beyond its reasonable use. For example, the capacity of a file folder should not be limited to the capacity
of a physical file folder, which presumably could contain only a few documents before becoming unwieldy. On the
other hand, a waste basket should not be used for anything other than holding discarded files. It should not be used,
for example, to eject a removable disk such as a floppy or CD.

4. Make Your Application Consistent
Make your application consistent with itself and with other applications, in both its appearance and its behavior.
This is one of the most important design principles, and probably the most famous, but it is also frequently ignored.
While this document serves as the basis for consistency between GNOME applications, you are encouraged to look
at and follow other application's conventions where this document provides no guidelines.

Consistency enables users to apply their existing knowledge of their computing environment and other applications
to understanding a new application. This not only allows users to become familiar with new applications more
quickly, but also helps create a sense of comfort and trust in the overall environment. Most of the recommendations
in the GNOME HI Guidelines are designed to help you create applications that are consistent with the GNOME en-
vironment and other GNOME applications.

A word of caution: a mis-applied or incomplete consistency is often worse than inconsistency. If your application in-
cludes an Undo menu item for consistency, but it is always disabled because your application does not actually sup-
port Undo, this will reduce users' trust in the availability of Undo in other applications on their desktop. Either make
your application support Undo, or eliminate the Undo menu item.
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5. Let Users Know What's Going On
Always keep the user informed of what's going on in your application by using appropriate feedback at an appropri-
ate time. The user should never have to guess about the status of the system or of your application. When the user
performs an action, provide feedback to indicate that the system has received the input and is operating on it. Feed-
back can be visual, audio, or both. If the system will take a long time to process the request, provide as much feed-
back as possible about how lengthy the operation will be. Types of helpful feedback include but are not limited to:
cursor changes, animated "throbbers", progress indicators, audio feedback such as a beep, and error messages. Error
messages should use simple language, clearly state the problem, and provide solutions or tell the user how to get out
of the current situation if possible.

It is critical that feedback be accurate and precise. If you display a determinate progress indicator to display the
state of completion of a task and it is inaccurate, the user will lose faith in progress indicators, and they will find the
environment less usable. If you display a generic error message that indicates that there is a problem but fails to pro-
vide enough information to diagnose or solve the problem, your users will be unable to continue with their task.

See Chapter 7 and Section 4 for more information on feedback.

6. Keep It Simple and Pretty
Your application should enable the user to concentrate on the task at hand. So, design your application to show only
useful and relevant information and interface elements. Every extra piece of information or interface control com-
petes with the truly relevant bits of information and distracts the user from important information. Hence, don't clut-
ter your interface, and don't overload the user with buttons, menu options, icons, or irrelevant information. Instead,
use progressive disclosure and other techniques to limit what the user sees at any given moment.

Finally, present your information and interface elements in an aesthetically pleasing manner. A disorganized, clut-
tered-looking interface with a few elements can be just as distracting as an organized interface with too much infor-
mation. Make sure that dialog elements are cleanly-aligned, and do not overuse or misuse color or graphics.

See Chapter 8 and Chapter 9 for more information on designing the visual appearance of your application.

7. Put the User in Control
Remember that computers exist to serve humans. A user should always feel in control, able to do what they want
when they want. This means you should generally avoid modes; users should be able to switch between different
tasks (and specifically, different windows) at any time.

The user should also be able to tailor aspects of their environment to fit personal preferences. It is very important,
however, to avoid the trap of allowing too much configuration, or allowing the configuration of parameters that most
users will not understand or find useful to modify. Wherever possible, inherit visual and behavioral parameters from
global preferences and settings such as the current GTK+ theme.

8. Forgive the User
We all make mistakes. Whether we're exploring and learning how to use the system, or we're experts who just hit the
wrong key, we are only human. Your application should therefore allow users to quickly undo the results of their ac-
tions.

If an action is very dangerous, and there is no way to undo the result, warn the user and ask for confirmation. Only
do this in extreme cases, though; if frequently faced with such confirmation messages, users begin to ignore them,
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making them worse than useless.

In all cases, the user's work is sacrosanct. Nothing your application does should lose or destroy user's work without
explicit user action. Among other techniques, this can be achieved by auto-saving backups of documents, and allow-
ing multiple levels of undo.

9. Enable Direct Manipulation
Wherever possible, allow users to act on objects and data directly, rather than through dialog boxes or explicit com-
mands. For example, it is more intuitive to drag a circle object around in a diagram rather than selecting a "Move"
command from a menu while the circle is selected.

See Chapter 10 for more information on direct manipulation.
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Chapter 2. Desktop Integration
There are two elements to basic integration with the user environment of the GNOME Desktop.

1. Place an entry for your application in the Applications menu. This is the primary mechanism by which users
discover and run applications.

2. If your application can open and save files, place entries for those file types in the application database and the
document type (MIME) database. This allows the file manager and other applications to automatically launch
your application when they encounter files your application can handle.

1. Placing Entries in the Applications Menu

Figure 2.1. The Applications menu

The Applications menu, which appears on the panel at the top of the screen by default, is the primary mechanism by
which users discover and run applications. You place entries in this menu by installing an appropriate .desktop
file.

The menu is arranged into a set of categories, such as Accessories and Games. Applications are placed in particular
categories by the set of keywords they include in their .desktop file.

Guidelines

• Assign your application to only one category on the Applications menu

• For application suites that wrap a number of smaller sub-applications into a single window, such as Evolution or
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OpenOffice.org, add a menu item for each sub-application. For example, the mail, calendar, and tasklist in Evo-
lution should each have their own menu item.

Technical details can be found in the VFolder [http://www.freedesktop.org/standards/VFolderDesktops.txt] and
Desktop file [http://www.freedesktop.org/standards/desktop-entry-spec.html] specifications.

1.1. Menu Item Names

1.1.1. Include a functional description in the menu name

User testing of MIT's Athena system [http://web.mit.edu/is/usability/aui/] revealed that users had difficulty finding
the file manager because they were unfamiliar with the name "Nautilus". Because users did not associate the word
"Nautilus" with the concept "file manager" the menu item did not help them. This is an example of not using the
user's language. See Section 3 for more on this topic.

In the menu item name, include a description of functionality in addition to the proper name of the application. This
is especially useful novice users, and to users of systems where numerous applications are installed by default. Users
are more likely to find your application if the name that appears in the menu includes a description of its functional-
ity.

Example 2.1. Including functional description in menu names

Original menu item Revised menu item

Nautilus Nautilus File Manager

1.1.2. Only put useful information in the menu name

Do not include words like "GNOME", "X WIndow System" or other platform details in Application menu names.
The user probably already knows what platform they are using, and if they don't, then application names are not the
right place to inform them.

Example 2.2. Removing non-essential information from menu names

Original menu item Revised menu item

Help System Help

GNOME Search Tool Search Tool

Do not include technical details when the user does not need to know them, or can infer them from context. Avoid
technical jargon unless the application is to be used only by a technical audience.

For example, when both a client and a server for something are listed in the menus, remove the word "Client" from
the menu name for the client.

Example 2.3. Removing technical jargon from menu names
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Original menu item Revised menu item

Gnome Batalla Naval Client Batalla Naval

Gnome Batalla Naval Server Batalla Naval Multiplayer Server

Gnome VideoLAN Client VideoLAN Movie Player

1.1.3. Menu name formats

1. If your application's proper name is already descriptive of its functionality, and not just suggestive, use the for-
mat: Application Name

Example 2.4. Using application's name as menu name

Application name Menu name

Dictionary Dictionary

Search Tool Search Tool

2. If there is a succinct functional description of your application, use the format: ApplicationName Func-
tionalDescription

Example 2.5. Using functional description in menu names

Application name Menu item name

The GIMP GIMP Image Editor

Evolution email sub-application Evolution Email

AbiWord AbiWord Word Processor

Galeon Galeon Web Browser

Gramps Gramps Genealogy

AisleRiot AisleRiot Solitaire

3. A few applications, particularly games, do not have appropriate functional descriptions (but note that many
games do). In this case, use Application Name as the menu name.

Example 2.6. Using applicaton's name as menu name where no functional description
exists

Application name Menu item name

Bomber Maze Bomber Maze
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1.2. Menu Item Tooltips

Tooltips help provide users with enough information to run the right application. Many users use tooltips to explore
a new environment.

Provide a tooltip for each Application menu item you add, following these guidelines:

Guidelines

• Phrase the tooltip as an imperative verb, for example "design", "write" or "check".

• Describe the most important tasks users can accomplish with your application.

• While tooltips should not be verbose, they should be longer and more descriptive than the item's name.

Example 2.7. Example tooltips for GNOME applications

Application Menu item tootlip

Character Map Insert special characters into documents

Memprof Check your applications for memory leaks

Same Gnome Arrange long chains of similarly-colored balls to elimi-
nate them

Gnome Batalla Naval Client Find and sink enemy ships in this networked version of
Battleship

2. Mapping Document Types to Applications
The document type (MIME) database allows users to specify their preferred applications for opening different types
of document. This is the mechanism by which Nautilus, Evolution and other applications decide which application
to run when they encounter a document they cannot open themselves.

It is important for users to be able to double-click on documents they see on the desktop, such as files and email
messages, and have them launch in their favorite application. Therefore, your GNOME application should associate
itself at install-time with all the document types it can handle. Technical details on doing this can be found in the
GnomeVFS API reference [http://developer.gnome.org/doc/API/gnome-vfs].

Chapter 2. Desktop Integration
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Chapter 3. Windows

1. Parts of Windows and System Interaction

1.1. Titles

Figure 3.1. Example of a window title

Give every window a title (with the exception of alerts and toolboxes). A good window title contains information
that is relevant to the user, and distinguishes a particular window from other open windows. Omit information that
does not assist in this selection, for example the application's version number or vendor name.

See the description of each particular window type for title formats.

1.2. Borders and Window Commands

Most windows have borders, except certain shaped windows and some torn-off windows. Do not attempt to draw
your own window borders, but instead provide hints to the window manager for the desired border type.

Different window commands are appropriate to different types of window. See the description of each particular
window type for a list of appropriate window commands. These are the possible window commands:

• Close. Closes the window. Always draw this as a button on the window border when available.

• Maximize. Causes the window to use all unused screen space.

• Minimize. Causes the window to be temporarily hidden. It will continue to appear on the desktop window list.

• Roll-up/Unroll. Shows only the title bar of the window, as if it has been "rolled up".

1.3. Modality

A non-modal window does not restrict the user's interaction with other open windows on the desktop in any way.
Using non-modal windows gives the user maximum flexibility to perform tasks within your application in any order
and by whichever means they choose.

A modal window, while it is open, prevents the user from interacting with other windows in the same application
(application modal), or in all applications, including the desktop itself (system modal).

Guidelines

• Use an application modal window only if allowing interaction with other parts of the application while the win-
dow is open could cause data loss or some other serious problem. Provide a clear way of leaving the modal win-
dow, such as a Cancel button in an alert.
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• Do not use system modal windows.

1.4. Focus

Focus is the means by which the user designates which window should receive data from the keyboard, mouse or
other input device. If using a screen reader or similar assistive technology, focus may also designate the window that
the user wants to receive information about. The focused window is considered the window the user is currently
"working with".

Ensure your application functions properly with the three different mechanisms by which windows can receive focus
in GNOME:

• Click-to-focus. A window is focused by clicking in it.

• Point-to-focus. A window is focused by moving the mouse pointer into it. Sometimes known as "sloppy focus".

• Keyboard focus. A window is focused by using a keyboard shortcut such as Alt-Tab.

2. Primary Windows

Figure 3.2. A typical primary window (gedit)
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A primary window usually presents a view of the user's data, such as a text document in a word processor applica-
tion, an image in a drawing program, or calculations in a calculator or spreadsheet application. It may also be a view
of something more abstract, like a game. A single instance of an application may have more than one primary win-
dow, and more than one kind of primary window.

A primary application window normally has a border, a menubar and a statusbar, and may also contain one or more
toolbars.

2.1. Title

For document-based applications, use Document Name as the window title.

Example 3.1. Using document names as window titles
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Application Example window title

AbiWord My Report.abw

Evolution Inbox

Music player U2 - Better Than the Real Thing

While document names are most pertinent to users, we understand that application developers may want to increase
recognition of their application. If you plan to include your application's name in the title of a primary window, use
the following format: Document Name - Application Name. This will ensure that the document name ap-
pears in limited space situations such as the system window list. Note that including the application name is not rec-
ommended, however.

For other types of application, use Application Name as the window title.

Example 3.2. Using application names as window titles

Application Window title

Dictionary Dictionary

Calculator Calculator

Do not place version numbers, company names, or other information that is of no immediate use to the user in the
window title. These consume space, making titles in limited spaces such as the system window list less useful, and
add more text the user has to scan to find useful information. In a "beta" product, where version numbers are critical
for bug information, placing version numbers can be useful, but remove them from stable releases. Place version in-
formation in the about box instead.

2.2. Window Commands

Close, Maximize/Restore, Minimize, Roll-up/Unroll

2.3. Relation between Documents and Windows

2.3.1. Single Document Interface (SDI)

Figure 3.3. A typical SDI application (Eye of GNOME)
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A single document interface places each document in its own primary window. Toolboxes and other utility windows
may be shared between multiple SDI documents, but closing them should have no effect on the document windows.
Use SDI for your GNOME application unless there is a compelling reason not to.

2.3.2. Controlled Single Document Interface (CSDI)

Figure 3.4. A typical controlled SDI application (The GIMP)

CSDI is reserved for applications where the extra overhead of a toolbar or menu per primary window is considered
unacceptable. This is rarely the case, as most documents require enough display space that the toolbar and menu add
relatively little overhead. The primary exception to this is an application that must handle large numbers of small
images well. Complex drawing applications, such as The GIMP, currently present this kind of interface. The main
toolbox of The GIMP is the control window.

2.3.3. Multiple Document Interface (MDI)
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Figure 3.5. A typical MDI application (gedit) showing three open documents on tabbed
pages

A multiple document interface presents a paned, tabbed or similar presentation of two documents within a single
window. MDI has several inherent usability problems, so its use is not encouraged in new GNOME applications. It
is better to open each document in a new primary window, with its own menubar, toolbars and statusbar, or allow
multiple instances of your application to be run simultaneously. In either case, this leaves it for the window manager
(acting on the user's preferences) rather than your application to decide how to group and present document win-
dows from the same application.

3. Utility Windows
Utility windows, such as palettes and toolboxes, normally have borders. They do not contain a menu bar, a toolbar,
or a statusbar.
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3.1. Instant apply and explicit apply

For windows that allow the user to change values or settings, such as property and preference windows, update those
values or settings immediately to reflect the changes made in the window. This is known as "instant apply". Do not
make the user press an OK or Apply button to make the changes happen, unless either:

• the change will take more than about one second to apply, in which case applying the change immediately could
make the system feel slow or unresponsive, or

• the changes in the window have to be applied simultaneously to prevent the system entering a potentially unsta-
ble state. For example, the hostname and proxy fields in a network properties window.

If either these conditions affect only a few of the controls in your window, arrange those controls together into one
or more groups, each with its own Apply button. Leave the rest of the controls as instant apply.

If most of the controls in your window are not suitable for instant apply, consider making the whole window ex-
"plicit apply". An explicit apply window has these three buttons in its button box, plus an optional Help button:

• Apply. Applies all the settings in the window, but does not close the window in case the user wishes to change
their mind.

• Cancel. Resets all settings in the window to those that were in force when the window was opened. Note: this
must undo the effects of all applications of the Try since the window was opened, not just the most recent one.

• OK. Applies all settings in the window, and closes the window.

Figure 3.6. Buttons in an explicit apply window

3.2. Default Buttons

When designing a dialog or utility window, you can assign the Return key to activate a particular button in the win-
dow. GNOME indicates this button to the user by drawing a different border around it. For example, the OK button
in Figure 3.6.

Choose the default button to be the most likely action, such as a confirmation action or an action that applies
changes in a utility window. Do not make a button the default if its action is irreversible, destructive or otherwise in-
convenient to the user. If there is no appropriate button in your window, to designate as the default button, do not set
one.

In particular, it is currently not recommended to make the Close button the default in an instant apply window, as
this can lead to users closing the window accidentally before they have finished using it.

3.3. Property Windows
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Figure 3.7. Example of a property window

Property windows allow the user to view and change the characteristics of an object such as a document, file, draw-
ing, or application launcher.

Title Format: Object Name Properties

Window Commands: Close, Minimize, Roll-up/Unroll

Buttons: Place a Close button in the lower right corner.

3.4. Preferences Windows

Figure 3.8. Example of a preferences window
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Preferences windows allow the user to change the way an application looks or behaves.

Title Format: Application Name Preferences

Window Commands: Close, Minimize, Roll-up/Unroll

Buttons: Place a Close button in the lower right corner.

3.5. Toolboxes

Figure 3.9. An example of a toolbox

A toolbox provides convenient access to a set of actions and toggles through a set of small toolbar-like buttons.
Toolboxes can be used to provide a specialized group of tools to augment a toolbar containing more universal items
such as Save and open. A single toolbox can be shared between multiple documents to save screen space.

Title Format: Toolboxes have no title

Window Commands: Close, Roll-up/Unroll
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Buttons: Toolboxes have no buttons

Resizing: Make toolboxes resizable, but only resize by discrete toolbox item widths. In other words, the user can re-
size the toolbox to be one item wide, two items wide, three items wide, etc. but not one and a half items wide.

Guidelines

• Only place buttons in a toolbox that do not open another window.

• Toolboxes are best used for modal toggle buttons that affect the operation of the mouse on the document, such as
a set of buttons for choosing between paintbrush, eraser, and fill modes in a drawing application. Buttons that
initiate actions upon clicking (such as a save button) are better placed in toolbars.

• Ensure that closing a toolbox does not close or otherwise alter any primary window with which it is associated,
unless your application uses the controlled SDI model.

• Do not place toolboxes in the system window list, unless your application uses the controlled SDI model. Tool-
boxes should always remain above all primary windows with which they are associated.

• If all primary windows associated with a toolbox are closed or minimized, hide the toolbox as well. Show the
toolbox again when one of the primary windows is opened or restored.

• Make a toolbox two items wide by default, unless it is broken into categories. Make categorized toolboxes four
items wide by default.

3.5.1. Toolbox Categories

Figure 3.10. A large toolbox broken into categories

Chapter 3. Windows

18



Break toolboxes with more than sixteen items into categories. The best size for a category is between four and ten
items. Give each category a label and a collapsing arrow. Clicking the label or the arrow toggles the category be-
tween a collapsed and uncollapsed state.

While categories may not be as visually appealing as a toolbox homogenously filled with beautiful icons, they make
an unwieldy large toolbox more managable. Picking a small icon from more than fifteen other items is a difficult
task. Additionally, categories allow users to hide sets of tool items that are not relevant to their current task.

4. Alerts

Figure 3.11. An example of an alert
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An alert provides information about the state of the application system, or asks for essential information about how
to proceed with a particular task. It is distinct from other types of window in that it is not directly requested by the
user, and usually contains a message or a question rather than editable controls. Since alerts are an unwelcome intru-
sion into the user's work, do not use them except where necessary to avoid potential data loss or other serious prob-
lems.

An alert has a border similar to that of a dialog, and is object modal.

Title Format. Alert windows have no titles, as the title would usually unnecessarily duplicate the alert's primary
text. This way, users can read and respond to alerts more quickly as there is less visual noise and confounding text.

Resizing. Alert windows are not resizable. If the user needs to resize your alert, the text is probably not concise
enough.

Alerts do not appear in the system window list. Consequently, take care to ensure that alerts stay above their parent
window.

4.1. Alert Text

Figure 3.12. Primary and Secondary Text Placement
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Primary Text. The primary text provides the user with a one sentence summary of the information or suggested ac-
tion. This summary should concisely contain the essential details of the problem or suggestion. Every alert has pri-
mary text, displayed in a bold font slightly larger than the default.

Denote primary text with the pango markup:

<span weight="bold" size="larger">Primary Text</span>

Secondary Text. Secondary text provides a more in-depth description of the problem and suggested action, includ-
ing possible side effects. Secondary text can also provide information that may be helpful in allowing the user to
make an informed decision. In most situations the user should only need the primary text to make a quick decision,
but they may read the secondary text if they are unsure of the proper course of action, or require extra details. Sec-
ondary text is optional, but if used, place it one text line height beneath the primary text using the default font size
and weight.

4.2. Alert Buttons

Figure 3.13. Button ordering and placement for alerts

Give all alerts an affirmative button that dismisses the alert and performs the action suggested in the primary text.
Provide a Cancel button for all alerts displayed in response to a user actions, such as Quit. If the alert warns of a
technical problem or other situation that could result in data loss, provide a Help button that provides more informa-
tion on the particular situation and explains the user's options. You may also provide buttons to perform alternate ac-
tions that provide another possible solution, fix potential problems, or launch related dialogs or programs.

Button Phrasing. Write button labels as imperative verbs, for example Save, Print. This allows users to select an
action with less hesitation. An active phrase also fits best with the button's role in initiating actions, as contrasted
with a more passive phrase. For example Find and Log In are better buttons than than Yes and OK.

• Affirmative Button. Place the affirmative button in the lower right corner of the alert. The affirmative button
accepts the action proposed by the alert, or simply dismisses the alert if no action is suggested (as is the case
with an information alert).

• Cancel Button. If the alert was produced in response to a user action, place a Cancel button immediately to the
left of the affirmative button. This provides an escape route for users to stop an action in response to new infor-
mation, or just if they clicked accidentally. Clicking the Cancel button reverts the application to its state prior to
the user action.

• Help Button. A Help button may be used to clarify alerts that present potentially destructive options. Place the
Help button in the lower left corner of the alert. When clicked, launch a help window clarifying the situation, de-
tailing the actions performed by the other buttons, and explaining any side-effects that each action may have.

• Alternate Buttons. Extra buttons may be used to provide alternates to the primary action proposed by the alert
text. Place these buttons to the left of the Cancel button, or the affirmative button if Cancel is not present. An ex-
ample of a common alternate action would be a Quit without Saving button in a save confirmation alert. This is
an alternative to the primary suggested action Save and the Cancel button.
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4.3. Spacing and Positioning Inside Alerts

Figure 3.14. Spacing inside an alert

Guidelines

• The border around all edges of the alert, and the space between the icon and the text, is 12 pixels.

• The horizontal spacing between the buttons is 6 pixels.

• The space below both the primary and secondary text is one line break at the standard font size, or 24 pixels if
you are using Glade.

• The top of the icon aligns with the top of the primary text.

• The text is left-aligned, in western locales.

4.4. Information Alerts

Figure 3.15. An information alert
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Use an information alert when the user must know the information presented before continuing, or has specifically
requested the information. Present less important information by other means such as a status bar message.

An information alert...

• uses the stock information icon.

• presents a selectable message and an OK button. The button is placed in the bottom right corner of the alert.
Pressing Enter or Escape dismisses the alert.

• may present a convenience button to give access to a relevant object. For example, a Details button in an ap-
pointment reminder alert that opens the appointment's property window. Place this button to the left of the affir-
mative button.

Window Commands: Roll-up/Unroll, Minimize (if the alert has no parent window), Close

4.5. Error Alerts

Figure 3.16. An error alert

Display an error alert when a user-requested operation cannot be sucessfully completed. Present errors caused by op-
erations not requested by the user by another means, unless the error could result in data loss or other serious prob-
lems. For example, an error encountered during an email check initiated by the user clicking a toolbar button should
present an error alert. However, an error encountered in an automated periodic email check would more appropri-
ately report failure with a status bar message.

An error alert...

• uses the stock error icon.

• presents a selectable message and an OK button. The button is placed in the bottom-right corner of the alert.
Pressing Enter may dismiss the error alert.

• may present a convenience button to allow immediate handling of the error. For example, a Format... button in a
"This disk is not formatted" alert. Place this button to the left of the affirmative button.

Window Commands: Roll-up/Unroll
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4.6. Confirmation Alerts

Figure 3.17. A confirmation alert

Present a confirmation alert when the user's command may destroy their data, create a security risk, or take more
than 30 seconds of user effort to recover from if it was selected in error.

A confirmation alert...

• uses the stock warning icon.

• presents a button labelled with a verb or verb phrase describing the action to be confirmed, or labelled OK if
such a phrase would be longer than three words. This button is placed in the bottom right corner of the alert.

• presents a Cancel button that will prevent execution of the user's command. This button is placed to the immedi-
ate left of the OK or equivalent button.

• may present an alternate action button or a convenience button. Place this button to the left of the Cancel button.

Window Commands: Roll-up/Unroll

4.6.1. Save Confirmation Alerts

Figure 3.18. A save confirmation alert
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Save confirmation alerts help ensure that users do not lose document changes when they close applications. This
makes closing applications a less dangerous operation.

Primary Text. Save changes to document Document Name before closing?

You may replace “document” with a more appropriate description, for example “image” or “diagram” if the docu-
ment in question is not primarily text.

Secondary Text. If you close without saving, changes from the last Time Period will be discarded

The secondary text provides the user with some context about the number of changes that might be unsaved.

Buttons. Close without Saving, Cancel, Save

4.7. Authentication Alerts

Figure 3.19. An authentication alert

Authentication alerts prompt the user for information necessary to gain access to protected resources, such as their
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username or password. Authentication alerts are a special kind of alert because they are both routine and largely un-
avoidable. Every attempt should be made to retain information entered into an authentication alert as long as is pos-
sible within security constraints.

An authentication alert:

• uses the stock authentication icon

• presents labelled fields for the user to fill with the data needed for authentication. Suggested fields are Username
and Password (in that order) where appropriate.

• may find it secure to retain username data longer than the password, in which case, pre-fill the username field
and give the password field the default focus when the alert is displyed.

• will present a button labelled with a verb or verb phrase describing the action authenticated, or OK if such a
phrase would be longer than three words. Place this button in the bottom right corner of the alert.

• will present a Cancel button that will prevent authentication. Place this button to the immediate left of the OK or
equivalent button.

• does not enable the OK or equivalent button until all fields have been filled by the user.

• may present an alternative action button or convenience button. Place this button to the left of the Cancel button.

When the user presses Return, move focus to the next field instead of activating the default button, unless the field
is the last one. In that case, activate the default button.

Window Commands: Roll-up/Unroll

5. Dialog Boxes

Figure 3.20. An example of a dialog box
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A dialog box provides an exchange of information, or dialog, between the user and the application. Use a dialog box
to obtain additional information from the user that is needed to carry out a particular command or task.

Title Format: Name of command that opened the dialog (without any trailing ellipsis)

Window Commands: Minimize, Roll-up/Unroll

Buttons: Follow the guidelines for Alert buttons, see Section 4.2.

Your dialog may specify a default button, that is activated when the user presses the Return key. See Section 3.2 for
guidance on choosing an appropriate default button.

5.1. Additional Buttons

You can include other buttons in a dialog's main button area in addition to the affirmative button and Cancel, but
any more than one or two such buttons will make the dialog appear complicated and difficult to use. As with any
other button, keep the labels as concise as possible to minimize this effect.

Guidelines

• Place buttons that apply to the dialog box as a whole in the main button area row at the bottom of the dialog box,
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to the left of the Cancel button.

• Place buttons that apply to one or a few controls next to their associated controls. For instance, place a Browse...
button at the trailing edge of the text field it fills in.

5.2. Layout

Arrange controls in your dialog in the direction that people read. In western locales, this is generally left-to-right,
top-to-bottom. Position the main controls with which the user will interact as close to the upper left corner as possi-
ble. Follow similar guidelines for arranging controls within groups in the dialog, and for specifying the order in
which controls are traversed using the Tab key.

When opening a dialog, provide initial keyboard focus to the component that you expect users to operate first. This
focus is especially important for users who must use a keyboard to navigate your application.

Provide and show sensible default values for as many of the controls in your dialog as possible when it is opened, so
the user does not have to generate the information from scratch. These defaults may come from system settings (for
example, hostname or IP address), or from information that the user has previously entered in this or another appli-
cation (for example, email address or network proxy).

See Chapter 8 for more detailed information on arranging controls in dialogs.

See Section 15 for information on using tabbed notebook controls in dialogs.

5.3. Common Dialogs

The gtk and GNOME libraries provide standard dialogs for many common tasks, including opening and saving files,
choosing fonts and colors, and printing. Always use these when the user is performing one of these tasks. You may
modify the dialogs to reflect the needs of your particular application (for example, adding preview Play and Stop
buttons to the Open File dialog in an audio application), but do not change or remove features so much as to make
them unrecognizable.

6. Assistants
An assistant is a secondary window that guides the user through an operation by breaking it into sequential steps.
Assistants are useful for making complex operations less intimidating, as they restrict the information visible to the
user at any given moment.

Because assistants provide a relatively small number of controls on the screen at any given time, they have sufficient
space for inline documentation. Therefore, do not include a Help button in an assistant window. If you cannot make
an operation sufficiently clear in an assistant without resorting to a Help button, you need to simplify it further.

Window Commands: Close, Minimize/Unminimize, Roll-up/Unroll

6.1. Introductory Page

The first page provides the user with the "big picture". Place the title of the assistant in the window's title bar and the
assistant's title area, along with an optional picture. Beneath this, state the goal of the assistant, and, if it is not obvi-
ous, where the user can find the information the assistant will be asking for.

Title Format: Assistant Title

Buttons: Cancel, Next
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Figure 3.21. Example of the first page of an assistant

6.2. Content Pages

Content pages contain the actual settings of the assistant. Summarize the type of setting present on each content page
in its title area. For example, Mail Server.

Title Format: Assistant Title - (Current Page of Total Pages)

Buttons: Cancel, Back, Next

Figure 3.22. Example of a middle page of an assistant
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6.3. Last Page

The last page should summarize the settings that will be changed by the assistant, and how the user can modify them
later.

Title Format: Finish Assistant Title

Buttons: Cancel, Back, Finish
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Chapter 4. Menus
Menus present the whole range of an application's commands to the user, and often a subset of its preferences. When
designing a new application, place common menu items in the same locations as they appear in other applications,
as this makes it much easier for the user to learn.

In most applications, only primary windows should have a menubar. Utility windows and dialog boxes should be
simple enough that their functions can be provided by controls such as buttons placed within the window.

Occasionally, however, a utility window or dialog is so complex that there would be too many such controls. In this
case, you may use a menubar provided that:

• the menus follow the same standard layout as described in Section 4

• the window does not include a dialog button area or any buttons that dismiss it, such as OK, Close or Cancel.
Place these commands on the File menu or equivalent instead.

Guidelines

• Label menu items with verbs for commands and adjectives for settings, according to the rules in Section 3.2.

• Make a menu item insensitive when its command is unavailable. For example, the Edit->Copy item, which is-
sues the command to copy selected data to the clipboard, should not be active when there is no data selected.

• Provide an access key for every menu item. You may use the same access key on different menus in your appli-
cation, but avoid duplicating access keys on the same menu. Note that unlike other controls, once a menu is dis-
played, its access keys may be used by just typing the letter; it is not necessary to press the Alt key at the same
time.

• Design your menu structure to avoid more than one level of submenus. Deep menu hierarchies are harder to
memorize and physically difficult to navigate.

• Do not have menus with less than three items on them (except the standard Help menu, which has only two
items by default). If you have a submenu with fewer than three items on it, move them into their parent menu. If
you have a top-level menu with fewer than three items on it, find another suitable menu to add them to, or find
suitable items from other menus to add to it.

1. The Menubar

Figure 4.1. A typical menubar

The menubar provides a number of drop-down menus. Only the menu titles are displayed, until the user clicks on
one of them. The menubar is visible at all times and is always accessible from the keyboard as well as the mouse, so
make all the commands available in your application available from here.

Guidelines

• Provide a menubar in each primary application window, containing at least a File and a Help menu.
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• Organize menu titles in the standard order— see Section 4.

• Do not disable menu titles. Allow the user to explore the menu, even though there might be no available items
on it at that time.

• Menu titles on a menubar are single words with their first letter capitalized. Do not use spaces in menu titles, as
this makes them easily-mistaken for two separate menu titles. Do not use compound words (such as WindowOp-
tions) or hyphens (such as Window-Options) to circumvent this guideline.

• Do not provide a mechanism for hiding the menubar, as this may be activated accidentally, resulting in the appli-
cation being "broken" for some users. If your users do require this option, provide a button elsewhere in the win-
dow (on a toolbar or in a toolbox, for example) that opens the menubar again.

2. Types of Menu

2.1. Drop-down Menus

Figure 4.2. A typical drop-down menu

A drop-down menu appears when the user clicks on its title in a menubar, or focuses the title and presses Return.

Guidelines

• Only place items on a menu that relate to that menu's title.

• Organize menu items in the standard order— see Section 4. For application-specific items where there is no
standard order, arrange in numerical or other logical order (for example, 50%, 100%, 200%), task order (for ex-
ample, Compile followed by Debug) or by expected frequency of use.
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• Limit top-level menus to a maximum of about 15 items. If you have any more items than this, consider moving a
functionally-related subset of the items into a submenu or a new top-level menu.

• Do not add or remove individual menu items while the application is running, make them insensitive instead.
Entire menus may be added or removed from the menubar at runtime, however, for example in component-based
applications.

• Immediately update menu items that are edited directly or indirectly by the user, such as those on the Open Re-
cent submenu and the Bookmarks menu.

2.2. Submenus

Figure 4.3. A drop-down menu with a submenu

A submenu appears when the user clicks its title, which is indicated by a small arrow symbol beside its label. You
can save space on long menus by grouping related commands onto a single submenu.

Guidelines

• Use submenus sparingly, as they are physically difficult to navigate and make it harder to find and reach the
items they contain.

• Do not create submenus with fewer than three items, unless the items are added dynamically (for example the
File->New Tab submenu in gnome-terminal).

• Do not nest submenus within submenus. More than two levels of hierarchy are difficult to memorize and navi-
gate.
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2.3. Popup Menus

Figure 4.4. A popup menu for a mail folder

Popup menus provide shortcuts to those menu items that are applicable only to the currently selected object. As
such, they are sometimes known as "context menus" or "shortcut menus". A popup menu is shown when the user
right-clicks on an object, or selects the object and presses Shift-F10.

Be aware that popup menus are used primarily by intermediate and advanced users. Even some users who have used
graphical desktops for many years do not know about popup menus until somebody shows them.

Guidelines

• Provide a popup menu for every object, selectable part, and text input target such as entry fields.

• Provide an access key for each item. However, to enhance their spatial efficency and readability, do not show
keyboard shortcuts in popup menus.

• Since the user may not be aware of their presence, do not provide functions that are only accessible from popup
menus unless you are confident that your target users will know how to use popup menus.

• Order items on a popup menu as follows:

• default action for object (same as double-clicking the object)

• other commands and settings in expected frequency-of-use order

• transfer commands such as Cut, Copy, and Paste

• Input Methods, where applicable
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• Popup menus need to be as simple as possible to maximize their efficiency. Do not place more than about ten
items on a popup menu, and do not use submenus.

3. Designing a Menu

3.1. Grouping Menu Items

Figure 4.5. Items grouped on a menu with separators

Menu separators are the horizontal dividing lines that visually separate groups of related items on a drop-down
menu, submenu, or popup menu. For example, the separators in Figure 4.5 divide the menu into five functionally-re-
lated groups. Good use of separators helps to "chunk" the information on a menu and make it easier to scan and
memorize.

Guidelines

• The best size for a group is around 2-5 items. Single-item groups are best placed at the top or bottom of a menu,
otherwise try to group them with other single items of the same type on the same menu.

• Order items within a group logically, numerically, in task order or by expected frequency of use, as appropriate.

• Only place one type of menu item in each group— command, mutable, checkbox or radio button. For example,
do not place commands (such as View->Reload) and settings (such as. View->Toolbar) in the same group.

3.2. Types of menu item
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3.2.1. Command Items

Figure 4.6. A group of command items on a menu

Command items are menu items that initiate a command or perform an action, such as Save, Print or Quit. They may
act on the currently active document in a document based application, or on the application itself.

Guidelines

• Provide a keyboard shortcut for standard or frequently used command items. See Section 2.3 for more informa-
tion on choosing shortcut keys.

• Do not remove command items from the menu when they are unavailable, make them insensitive instead. This
allows the user to infer what functionality the application provides even if it is not currently available, and
keeping the menu structure static makes it easier to memorize.

• Label the menu item with a trailing ellipsis ("...") only if the command requires further input from the user be-
fore it can be performed. Do not add an ellipsis to items that only present a confirmation dialog (such as Delete),
or that do not require further input (such as Properties, Preferences or About).

3.2.2. Mutable Command Items

A mutable command item changes its label when selected. For example, View->Reload in a browser may change to
Stop to allow the user to interrupt the operation if it is taking a long time.

Note that mutable menu items can be problematic because the user never sees the menu item changing, so it is not
obvious that a different function has become available.

Guidelines

• If your mutable menu items are command items, and you have sufficient space on your menu, consider provid-
ing two adjacent menu items for the commands instead. Then make the items sensitive or insensitive as the situ-
ation demands. This also makes it easier for the user to tell when different shortcuts are available for each of the
commands, for example Ctrl-R for Reload, and Esc for Stop.

• Do not use mutable menu items to toggle a two-state setting (for example, Show Toolbar and Hide Toolbar).
Present such items as a single checkbox item instead.

3.2.3. Checkbox Items

Chapter 4. Menus

36



Figure 4.7. A group of checkbox items on a menu

A checkbox menu item shows the current state of a two-state setting, and allows the user to toggle it by selecting the
menu item.

Guidelines

• Use a checkbox menu item only when it is obvious from the label what the set and unset states mean. This usu-
ally means that the two states are logical or natural opposites, such as "on" and "off". If this is not the case, use
two radio button items instead.

• Never change the label of a checkbox menu item in response to the user selecting the item.

3.2.4. Radio Button Items

Figure 4.8. A group of radiobutton items on a menu

Radio button menu items show which of two or more mutually-exclusive settings are currently selected, and allow
the user to choose a different setting by selecting its menu item.

• If you need to offer a choice of two mutually-exclusive settings to the user, use a group of two radio button items
instead of a single checkbox menu item if the settings are not clearly opposites. For example, represent View as
Icons and View as List as two radio button items.

• Never change the label of a radio button menu item in response to the user selecting or deselecting the item.

4. Standard Menus
Most applications have many functions in common, such as Cut, Copy, Paste and Quit. To aid learning and memora-
bility, these menu items, and the menus on which they appear, must appear with the same labels and in the same or-
der in every application. The same commands must also behave the same way in different applications, to avoid sur-
prising the user.
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This section details the most common menus, menu items and their behaviors. You will not need all of these menus
or menu items in every application you write, but do preserve the order of the menu titles and of the menu items that
you do use.

Guidelines

• Place application-specific menus after the Format menu and before the Go menu

• Place application-specific menu items towards the middle of a standard menu, unless they logically fit with one
of the standard groups already on the menu.

Figure 4.9. A menubar showing all the standard menu titles in their correct order

4.1. File

The File menu contains commands that operate on the current document. It is the left-most item in the menubar be-
cause of its importance and frequency of use, and because it is a relevant menu in many applications. Historically,
because most applications already had this menu, and because the distinction between closing documents and clos-
ing windows became blurred over time, the File menu has also become the standard location for Quit.

The items on the File menu are generally ordered by locality, closest first. That is, items to save or load from file,
followed by printing, followed by sending to a remote user. Try to maintain this ordering if you have to add new
items to the menu.

If your application does not operate on documents, give this menu a more appropriate name. For example, many
games should have a Game instead of a File menu. However, place the Quit menu item last on this menu he-
nonetless.

Figure 4.10. A generic File menu
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4.1.1. Creation and Opening Operations

Table 4.1. Creation and Opening operation menu items

Label Shortcut Description

New Ctrl-N Creates a new document. Open a new
primary window, with the title Doc-
ument name, containing a blank
document. How this window is dis-
played, e.g. as a tab or a separate
window, is up to the window man-
ager.

If your application can create a num-
ber of different types of document,
you can make the New item a sub-
menu, containing a menu item for
each type. Label these items New
document type, make the first
entry in the submenu the most com-
monly used document type, and give
it the Ctrl-N shortcut.
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Note: A blank document will not nec-
essarily be completely blank. For ex-
ample, a document created from a
template may already contain some
data.

Open... Ctrl-O Opens an existing document in a new
window. Present the user with a stan-
dard Open File dialog from which
they can choose an existing file. If
the chosen file is already open in the
application, raise that window instead
of opening a new one.

4.1.2. Saved State Operations

Table 4.2. Saved State Operation menu items

Label Shortcut Description

Save Ctrl-S Saves the document with its current
filename. If the document already has
a filename associated with it, save the
document immediately without any
further interaction from the user. If
there are any additional options in-
volved in saving a file (eg. DOS or
UNIX-style line endings in a text
file), prompt for these first time the
document is saved, but subsequently
use the same values each time until
the user changes them.

If the document has no current file-
name or is read-only, selecting this
item should be the same as selecting
Save As.

Save As... Shift-Ctrl-S Saves the document with a new file-
name. Present the user with the stan-
dard Save As dialog, and save the file
with the chosen file name.

Save a Copy... None Prompts the user to enter a filename,
with which a copy of the document is
then saved. Do not alter either the
view or the filename of the original
document. All subsequent changes
are still made to the original docu-
ment until the user specifies other-
wise, for example by choosing the
Save As command.

Like the Save As dialog, the Save a
Copy dialog may present different
ways to save the data. For example,
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an image may be saved in a native
format or as a PNG.

Revert None Reverts the document to the last
saved state. Present the user with a
warning that all changes will be lost,
and offer the option of cancelling be-
fore reloading the file.

Save Version... None An alternative to the Save a Copy
command. Only use this item in con-
junction with the Restore Version.
command.

Restore Version... None Prompts the user for a version of the
current document to be restored.
Present the user with with a warning
that all changes will be lost, and offer
the option of cancelling before restor-
ing the version. Only use this item in
conjunction with the Save Version
command.

Versions... None An alternative to the Save Version
and Restore Version commands. Use
this when more utilities, such as a
diff, are available.

4.1.3. Export Operations

Table 4.3. Export Operation menu items

Label Shortcut Description

Page Setup None Allows the user to control print-re-
lated settings. Present the user with a
dialog allowing the user to set such
options as portrait or landscape for-
mat, margins, and so on.

Print Preview Shift-Ctrl-P Shows the user what the printed doc-
ument will look like. Present a new
window containing an accruate repre-
senation of the appearance of the
document as it would be printed. The
libgnomeprintui library provides a
standard Print Preview window that
you should use if possible.

Print... Ctrl-P Prints the current document. Present
the user with a dialog allowing them
to set options like the page range to
be printed, the printer to be used, and
so on. The dialog must contain a but-
ton labelled Print that starts printing
and closes the dialog. The libg-
nomeprintui library provides a
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standard Print dialog that you should
use if possible.

Send To... Ctrl-M Provides the user a means to attach or
send the current document as an
email or email attachment, depending
on its format.

You may provide more than one
Send item depending on which op-
tions are available. If there are more
than two such items, move them into
a submenu. For example, if only
Send by Email and Send by Fax are
available, leave them on the top-level
menu If there is a third option, such
as Send by FTP, place all the options
in a Send submenu.

4.1.4. File Properties

Table 4.4. Properties menu items

Label Shortcut Description

Properties None Opens the document's Properties win-
dow. This may contain editable infor-
mation, such as the document au-
thor's name, or read-only informa-
tion, such as the number of words in
the document, or a combination of
both.

4.1.5. Closing Operations

Table 4.5. Closing Operation menu items

Label Shortcut Description

Close Ctrl-W Closes the current document. If it has
unsaved changes, present the user
with a confirmation alert giving the
option to save changes, discard them,
or cancel the action without closing
or saving the document.

If the window you are closing is the
last open document in the applica-
tion, the correct action depends on
your application type:

• Single document interface: close
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the application

• Controlled single document inter-
face: leave only the control win-
dow open

• Multiple document interface:
close the current document and
create a new blank document

Quit Ctrl-Q Closes the application. If there are
unsaved changes in any open docu-
ments, present the user with a confir-
mation alert for each affected docu-
ment, giving the option to save the
changes, discard them, or cancel. If
there are no unsaved changes, close
the application immediately without
presenting any further messages or
dialogs.

4.2. Edit

The Edit menu contains items relating to editing both the document (clipboard handling, search and replace, and in-
serting special objects) and the user's preferences. Preferences are edited here rather than on a Settings menu, be-
cause:

• most applications' preferences windows are accessed via a single menu tem, and single-item menus offer poor
usability

• most applications already contain a suitable Edit menu.

Figure 4.11. A generic Edit menu
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4.2.1. Modification History

Document-based applications should maintain a history of modifications to a document and the state of the docu-
ment between each action. The Undo and Redo commands move backwards and forwards through this history.

Table 4.6. Modification History menu items

Label Shortcut Description

Undo action Ctrl-Z Undoes the previous action in the
undo history list. Revert the docu-
ment to its state before the previous
action was performed.

Note: provide a separate Undo and
Redo menu item even if your applica-
tion only supports one level of undo.

Redo action Shift-Ctrl-Z Performs the next action in the undo
history list, after the user has moved
backwards through the list with the
Undo command. Move the user one
step forwards again, restoring the
document to the state it was in after
that action was originally performed.
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Note: provide a separate Undo and
Redo menu item even if your applica-
tion only supports one level of undo.

4.2.2. Manipulating Selected Data

Table 4.7. Selected Data Manipulation menu items

Label Shortcut Description

Cut Ctrl-X Removes the selected content and
places it onto the clipboard. Visually,
remove the content from the docu-
ment in the same manner as Delete.

Copy Ctrl-C Copies the selected content onto the
clipboard.

Paste Ctrl-V Inserts the contents of the clipboard
into the document. If there is no cur-
rent selection, use the caret as the in-
sertion point. If there is a current se-
lection, replace it with the clipboard
contents.

Paste Special... Shift-Ctrl-V Inserts a non-default representation
of the clipboard contents into the
document. Open a dialog presenting a
list of the available formats from
which the user can select. For exam-
ple, if the clipboard contains a PNG
file copied from a file manager, the
image may be embedded in the docu-
ment, or a link to the file inserted so
that changes to the image on disk are
always reflected in the document.

Duplicate Ctrl-U Creates a duplicate copy of the se-
lected object. Do not prompt for a
name for the duplicate object, but
give it a sensible default (for exam-
ple, Copy of Shop-
pingList.abw) and allow the user
to change it later. Place the duplicate
copy as near the original as possible
without overlapping it, even if this
means breaking the current sort order
within the container, so the user sees
it immediately.

Delete Delete Removes the selected content without
placing it on the clipboard.

Select All Ctrl-A Selects all content in the current doc-
ument.

Deselect All Shift-Ctrl-A Deselects all content in the current
document. Only provide this item in
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situations when no other method of
undoing selection is possible or ap-
parent to the user. For example, in
complex graphics applications where
selection and deselection is not usu-
ally possible simply by using the cur-
sor keys.

Note: Do not provide Deselect All in
text entry fields, as Shift-Ctrl-hex
digit is used to enter unicode charac-
ters so its shortcut will not work.

4.2.3. Searching and Replacing

Table 4.8. Search and Replace menu items

Label Shortcut Description

Find Ctrl-F Opens a window or dialog allowing
the user to search for specific content
in the current document. Highlight
each match in-place.

If the command allows the user to
search for content in places other
than the current document, for exam-
ple other open documents, other doc-
uments on disk, or a remote network
location, label this item Search in-
stead of Find.

Find Next Ctrl-G Selects the next instance of the last
Find term in the current document.

Find Previous Shift-Ctrl-G Selects the previous instance of the
last Find term in the current docu-
ment.

Replace... Ctrl-R Opens a window or dialog allowing
the user to search for specific content
in the current document, and replace
each occurrence with new content.

4.2.4. Inserting Special Objects

Where applicable, provide items on the Edit menu that insert special objects such as images, links, GUI controls or
the current date and time.

If you have up to three types of object that can be inserted, add them as individual items to this menu, for example
Insert Image, or Insert External Link. If you have between three and six types, place them on an Edit->Insert sub-
menu. If you have more than six, add a separate Insert menu to the menubar.

4.2.5. User Preferences
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Table 4.9. User Preferences menu items

Label Shortcut Description

Preferences None Opens a preferences window allow-
ing the user to change preferences for
the whole application. Changes will
apply to all running and subsequent
instances of the application.

4.3. View

The View menu contains only items that affect the user's view of the current document. Do not place any items on
the View menu that affect the the content of the current document. (Exception: View->Reload may change the cur-
rent contents if, for example, the document is a webpage that has been recently updated on the server).

Figure 4.12. A generic View menu

4.3.1. Toolbar and Statusbar

Table 4.10. Toolbar and Statusbar menu items

Label Shortcut Description

Toolbar None Shows or hides the application's tool-
bar. This is a checkbox menu item.
Include this item in every application
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that has a single toolbar. See Section
2 for information on how to deal with
multiple toolbars.

Statusbar None Shows or hides the application's sta-
tusbar. This is a checkbox menu item.
Include this item in every application
that has a statusbar.

4.3.2. Content Presentation

Table 4.11. Content Presentation menu items

Label Shortcut Description

Icons None Shows the contents of the selected
container as rows and columns of
large icons, each with its name under-
neath. This is a radio button menu
item.

List None Shows the contents of the selected
container as a list of small icons, pos-
sibly in multiple columns, each with
its name on its right-hand side. This
is a radio button menu item.

Details None Shows the contents of the selected
container as single column of small
icons, each with its name on its right-
hand side. Additional columns give
extra information about the object
each icon represents, for example the
size and modification date of files in
a file manager. This is a radio button
menu item.

If your application has no need for
both List and Details modes, use the
List item for whichever of the two
modes you support.

Sort By... None Sorts the contents of an container by
user-specified criteria. Open a dialog
allowing the user to choose from pre-
defined sort keys (for example,
Name, Size, or Modification Date in
a file manager), or to specify their
own if applicable.

Filter... None Hides objects that are not of interest
to the user. Open a dialog allowing
the user to choose from a list of types
of object they want to display, or to
enter their own criteria (for example,
a regular expression matched against
a particular property of the objects).
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Zoom In Ctrl-+ Zooms into the document. Make the
center of the new view the same as
the center of the previous view.

Zoom Out Ctrl-- Zooms out of the document. Make
the center of the new view the same
as the center of the previous view.

Normal Size Ctrl-= Resets the zoom level back to the de-
fault value, normally 100%. Make the
center of the new view the same as
the center of the previous view.

Best Fit None Makes the document fill the window.
Show the document, or the current
page of the document, at as high a
zoom level as will fit in the window
whilst allowing the whole document
or page to be visible without
scrolling.

Refresh Ctrl-R Redraws the current view of the doc-
ument from local storage. For exam-
ple, in a web browser application,
this would redraw the page from the
browser page cache.

If you want to check if the actual
content has changed before
refreshing the view, for example,
checking a web page on a web server,
label this item Reload rather than Re-
fresh. If your application requires
both Reload and Refresh, use
Shift-Ctrl-R as the shortcut for
Reload.

4.4. Insert

The Insert menu lists the type of special objects that can be inserted into the document at the current caret position,
for example images, links, page breaks or GUI objects. Only provide this menu if you have more than about six
types of object that can be inserted, otherwise place individual items for each type on the Edit menu.

Figure 4.13. A generic Insert menu
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The types of object will vary between applications, but the table below shows some common types that may be ap-
plicable.

Table 4.12. Insert menu items

Label Shortcut Description

Page Break None Inserts a page break at the caret posi-
tion. Show the page break visually,
for example as a dotted line across
the page, unless the user has specifi-
cally requested not to see them.

Date and Time... None Inserts the current date and/or time at
the caret position. Open a dialog giv-
ing a choice of date and time formats.
If applicable, also offer the choice to
insert either as plain text, so the spec-
ified date and time will always ap-
pear in the document, or as a special
field that will updated every time the
document is opened, refreshed or
printed.

Symbol... None Inserts a special symbol, such as a
mathematical symbol or foreign char-
acter, at the caret position. Open a di-
alog showing all the available sym-
bols as a table, from which the user
can choose. The user must be able to
add multiple symbols to the docu-
ment at one time without having to
close and re-open the dialog.

Sheet... None Adds a new sheet to the current
workbook. Do not prompt for a
name, but choose a sensible default
(such as Sheet-2) and allow the user
to change it later.
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Rows... None Adds new rows to a table in which
one or more rows or cells are cur-
rently selected. Open a dialog asking
whether to insert rows above or be-
low the current selection, and for any
other required information. Copy the
row format from the last or first row
of the current selection respectively,
unless the user specifies otherwise.

Columns... None Adds new columns to a table in
which one or more columns or cells
are currently selected. Open a dialog
asking whether to insert columns to
the left or right of the current selec-
tion, and for any other required infor-
mation. Copy the column format
from the right- or left-most column of
the current selection respectively, un-
less the user specifies otherwise.

Image... None Inserts an image into the document
from a file. Present a standard Open
File dialog filtered on acceptable file
types, from which the user can
choose an image file to insert.

Graph... None Inserts a graph into the document.
Open a dialog or assistant that allows
the user to build (or open from a file)
a graph of their choice, using the cur-
rent selection as an indication of
which values, axis labels and data la-
bels to use.

From FIle... None Inserts an object from any acceptable
file type, for example plain text, for-
matted text, or an image. Present a
standard Open File dialog filtered on
acceptable file types, from which the
user can choose a file to insert.

External Link... None Inserts a link to an object stored in a
different file, or on a remote system.
The object is not embedded in or
saved with the document, only a link
to it. Open a dialog in which the user
can type or choose the name of the
object, for example a filename or a
webpage URL. Show the link in the
document in as informative way as
possible. For example, show a link to
an image as a thumbnail of that im-
age, unless the user specifies other-
wise.

4.5. Format
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A Format menu contains commands to change the visual appearance of the document. For example, changing the
font, color, or line spacing of a text selection.

The difference between these commands and those on the View menu is that changes made with Format commands
are persistent and saved as part of the document, for example as HTML or RTF tags.

Figure 4.14. A generic Format menu

Items found on the Format will be very application-specific, but some common items are listed in the table below.

Table 4.13. Format menu items

Label Shortcut Description

Style... None Sets the style attributes of the se-
lected text or objects either individu-
ally or to a named, predefined style.
Open a dialog allowing the user to set
attributes such as bold, italic, size and
spacing individually, and to create
their own named styles where appli-
cable.

Font... None Sets the font properties of the se-
lected text or objects. Open a dialog
allowing the user to choose font, size,
style, color, or whatever other at-
tributes are applicable.

Paragraph... None Sets the properties of the selected
paragraph. Open a dialog allowing
the user to choose style, line spacing,
tabulation, or whatever other at-
tributes are applicable.

Bold Ctrl-B Toggles the boldness of the current
text selection on or off. If some of the
selection is currently bold and some
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is not, this command should bolden
the selected text.

Italic Ctrl-I Toggles the italicisation of the cur-
rent text selection on or off. If some
of the selection is currently italicised
and some is not, this command
should italicise the selected text.

Underline Ctrl-U Toggles underlining of the current
text selection. If some of the selection
is currently underlined and some is
not, this command should underline
the selected text.

Cells... None Sets the properties of the selected ta-
ble cells. Open a dialog allowing the
user to choose alignment, borders,
shading, text style, number format, or
whatever other attributes are applica-
ble.

List... None Sets the properties of the selected list,
or turns the selected paragraphs into a
list if they are not already formatted
as such. Open a dialog allowing the
user to choose number or bullet style,
spacing, tabulation, or whatever other
attributes are applicable.

Layer... None Sets the properties of all or selected
layers of a multi-layered document.
Open a dialog allowing the user to
choose name, size, visibility, opacity,
z-ordering, or whatever other at-
tributes are applicable.

Page... None Sets the properties of all or selected
pages of the document. Open a dialog
allowing the user to choose paper
size, orientation, columns, margins,
or whatever other attributes are appli-
cable.

4.6. Bookmarks

Provide a Bookmarks menu in any application that allows the user to browse files and folders, help documents, web
pages or any other large information space.

Figure 4.15. A generic Bookmarks menu
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Table 4.14. Bookmark menu items

Label Shortcut Description

Add Bookmark Ctrl-D Adds a bookmark for the current doc-
ument to the default bookmark list.
Do not pop up a dialog asking for a
title or location for the bookmark, in-
stead choose sensible defaults (such
as the document's title or filename as
the bookmark name) and allow the
user to change them later using the
Edit Bookmarks feature.

Edit Bookmarks Ctrl-B Allows the user to edit the applica-
tion's bookmark list. Open a window
in which the user can arrange book-
marks into a hierarchy, move, copy,
and delete bookmarks, and change
their properties.

4.7. Go

A Go menu provides commands for quickly navigating around a document or collection of documents, or an infor-
mation space such as a directory structure or the web.

The contents of the menu will vary depending on the type of application. Different standard menus are presented
here for browser-based and document-based applications , but your application may require a combination of both.

Figure 4.16. A generic Go menu for a browser application

Table 4.15. Go menu items for a browser application

Label Shortcut Description

Back Alt-Left Navigates to the previous document
in the browser's history list.

Forward Alt-Right Navigates to the next document in the
browser's history list.

Up Alt-Up Navigates to the current document's
(or folder's) parent document (or
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Label Shortcut Description

folder). For a document browser,
such as an online help viewer, this
usually means navigating to the en-
closing sub-section, section, chapter
or contents page.

Home Alt-Home Navigates to a starting page defined
by the user or the application.

Location... None Navigates to a user-specified URI.
Open a dialog into which the user can
type a suitable URI, or select one
from a list where applicable (for ex-
ample, a file selection dialog for ap-
plications that can handle file://
URIs).

Figure 4.17. A generic Go menu for document-based applications

Table 4.16. Go menu items for a document-based application

Label Shortcut Description

Previous Page PageUp Navigates to the previous page in the
document.

Next Page PageDown Navigates to the next page in the doc-
ument.

Go to Page... None Navigates to a user-specified page
number. Open a dialog into which the
user can type a page number.

Text-based applications may also in-
clude a Go to Line... menu item,
which allows the user to jump to a
specified line number.

First Page Ctrl-Home Navigates to the first page in the doc-
ument.

Last Page Ctrl-End Navigates to the last page in the doc-
ument.
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4.8. Windows

The Windows menu contains commands that apply to all of the application's open windows. Only use a Windows
menu in multiple document interface (MDI) applications.

You may also label this menu Documents, Buffers, or similar according to the type of document handled by your ap-
plication.

The first items on this menu are a numbered list of the application's primary windows, for example
1shoppinglist.abw. Selecting one of these items raises the corresponding window.

Figure 4.18. A generic Windows menu

Table 4.17. Windows menu items

Label Shortcut Description

1. first open window title

2. second open window ti-
tle

etc.

None Raises the corresponding window to
the top of the window stack.

Save All None Saves all open documents. If any
documents have no current filename,
prompt for a filename for each one in
turn using the standard Save dialog.

Close All Shift-Ctrl-W Closes all open documents. If there
are any unsaved changes in any docu-
ments, post a confirmation alert for
each one in turn.

4.9. Help

The Help menu provides access to all online documentation for your application. This includes both the user guide,
and the About window which includes a brief description of your application's functionality.

Figure 4.19. A generic Help menu
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Table 4.18. Help menu items

Label Shortcut Description

Contents F1 Opens the default help browser on
the contents page for the application.

About None Opens the About dialog for the appli-
cation. Use the standard dialog pro-
vided by the GNOME libraries,
which contains the name and version
number of the application, a short de-
scription of the application's func-
tionality, author contact details, copy-
right message and a pointer to the li-
cence under which the application is
made available.
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Chapter 5. Toolbars
A toolbar is a strip of controls that allows convenient access to commonly-used functions. Most toolbars only con-
tain graphical buttons, but in more complex applications, other types of controls such as dropdown lists, can also be
useful.

Figure 5.1. Example toolbar from a web browser window

Careful and consistent toolbar design speeds up the user's task by giving direct access to functions that would other-
wise be hidden on a menu. Use them only for the most important functions, however. Having too many toolbar con-
trols reduces their efficiency by making them harder to find, and too many rows of toolbars reduces the amount of
screen space available to the rest of the application.

1. Appearance and Content
The effectiveness of toolbars is increased by maintaining a level of consistency between different applications. The
toolbar is one of the first parts of your application that a user will see the first time they run it, so by providing a
toolbar that looks familiar to them, you can immediately make them feel comfortable about using your application.

As well as following the recommendations and examples given in this section, look at the toolbars in other well-
designed GNOME 2.0 applications for guidance when deciding what— and what not— to put on your application's
toolbar.

However many toolbars or toolbox windows your application offers, provide one main toolbar by default that con-
tains a representative subset of the application's overall functionality. Many of the buttons on this toolbar will be the
same regardless of the type of application.

For example, the main toolbar in an office application will nearly always have New, Open and Save as its first three
toolbar buttons. Similarly, the first few buttons in a browser application should always include Back, Forward, Stop
and Reload, in that order.

Guidelines

• Place only the most commonly-used application functions on your toolbars. Don't just add buttons for every
menu item.

• By default, have your toolbars appear directly below the main menu bar.

• Allow toolbars to be turned on and off in your application's Preferences dialog and by using the View->Toolbar
menu item. If there is more than one toolbar, they are turned on and off by individual entries in the Tool-
View->bar submenu.

• All functions that appear on your toolbars must also accessible via the main menu bar, either directly (i.e. an
equivalent menu item) or indirectly (e.g. in the Options->Settings dialog).

• Arrange toolbar buttons in the same order and groupings as their equivalents on the main menu bar. In particular,
always group sets of mutually-exclusive toolbar buttons.

• Don't add buttons for Help, Close or Quit to your toolbar by default, as these are rarely used and the space is bet-
ter used for more useful controls. Similarly, only provide buttons for Undo, Redo and the standard clipboard

Chapter 5. Toolbars

58



functions if there is space on the toolbar to do so without sacrificing more useful, application-specific controls.

• Provide options to show toolbar buttons as text, graphics or both— see Figure 5.2 for the menus to use for con-
trolling toolbar display. Also provide an option to return all toolbars in your application to the control center de-
fault for this setting.

• Allow users to configure toolbars to contain their own selection of commands, in whatever order they choose.
Provide an option in the configuration dialog to return the toolbars to their default configuration.

• Save your application's toolbar position and contents as part of the application configuration, and restore them
when the application is restarted.

1.1. Vertical Toolbars

In general, don't use vertical toolbars. The eye does not scan vertically as well as it does horizontally, groups of mu-
tually exclusive buttons are less obvious when arranged vertically, and showing button labels is more awkard and
less space-efficient. Also, some toolbar controls just cannot be used vertically, such as dropdown lists.

Only consider using a vertical toolbar if:

• the configuration of the application window means there would be a lot of wasted space if a horizontal toolbar
was used instead, or

• your application would otherwise require three or more rows of toolbars to appear below the main menu bar by
default. Note however that in this situation, the better alternative is usually to display fewer toolbars by default.

If you must use a vertical toolbar, ensure the user can configure it to appear horizontally if they prefer.

2. Controlling Display and Appearance
For each toolbar in your application, the user should be able to choose whether or not to show that toolbar, and
whether to show its contents as icons only, text only or both.

Guidelines

• Allow the user to override the control center toolbar defaults for your particular application in the application's
Preferences dialog. In particular, ensure that the user can:

• separately choose to show each toolbar in your application as icons only, text only, or both

• return the icon/text/both status for all toolbars in your applicaton to the system default

• choose to show text labels either to the side of some or below all toolbar icons, and to return this setting to
the system default

• return the layout and ordering of all toolbars in your application to the application default

• If your application has a single toolbar, allow the user to turn it on or off with a View->Toolbar checkbox menu
item.

• If your application has two or three toolbars, allow the user to turn them on or off individually by placing a menu
item for each one on the application's View menu. For example, Main Toolbar, Drawing Toolbar, Formatting
Toolbar. Place the items together in a single group on the menu, with Main Toolbar first (if your application has
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one), followed by the others in alphabetical order.

• If your application has more than three toolbars, allow the user to turn them on or off individually by placing a
menu item for each one in a Toolbars sub-menu on the application's View menu. Place the Main Toolbar item
first (if your application has one), followed by the others in alphabetical order.

Figure 5.2. Example View menu fragments for applications with one toolbar (left), two
or three toolbars (middle), or four or more toolbars (right)

3. Labels and Tooltips
Most controls that appear on your toolbar will require a text label that appears on, below or beside it. Keep this de-
scription as short as possible, preferably a single verb. For example, Open or Undo.

Every control that appears on your toolbar should have a tooltip, whether or not that control has an associated text
label. The tooltip should be a concise description of the control, but should provide more information than its text la-
bel where possible. For example, Open an existing document, or Undo last operation.

Guidelines

• For buttons that correspond directly to menu items, make the text label the same as the menu item, but without
any trailing ellipsis. For example, Open, Save.

• Do not provide access keys for toolbar buttons. Since toolbars are in the same keyboard focus context as the
menubar, it would be too difficult to provide unique access keys for every menu title and toolbar control. Tool-
bars are primarily intended as a shortcut for mouse users, although they are keyboard-navigable for accessibility
reasons.

• If your toolbar is configured to show labels below button icons, show a label for every control on the toolbar.
For example:

Figure 5.3. Toolbar with labels under all buttons

• If your toolbar is configured to show labels beside button icons rather than below them (using the "priority text"
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setting), do not show labels for every button. Show labels only for the buttons that will be most-frequently used.
Choose no more than four such icons on any one toolbar, otherwise the effect will be diluted and the toolbar will
become very wide. For example:

Figure 5.4. Toolbar with "priority text" labels beside the first few buttons only

If you are unsure which buttons will be most frequently used, choose the first few buttons on your toolbar and
provide labels for those only.

• Ensure all toolbar controls have tooltips. The tooltip should be more descriptive than the corresponding menu
item, if it has one, but still concise. For example, Create new document for the Open toolbar button. Use sen-
tence capitalization for tooltips—see Section 3.2 for more information.
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Chapter 6. Controls

1. Using Controls Effectively
GNOME provides a set of controls, also known as widgets, which allow users to interact with your applications. Us-
ing these controls appropriately and not altering their standard behavior is important. This allows users to predict the
effects of their actions, and thus learn to use your application more quickly and efficiently. Controls that behave in
non-standard ways break the user's mental model of how your application works, and dilute the meaning of the in-
terface's visual language.

2. Terminology
Although they are known as "widgets" in the GNOME APIs and developer documentation, do not use this term in
your user interface or user documentation. Refer to them by their specific names (for example, "buttons" or
"menus"), or by the generic name "controls".

3. Sensitivity
Sometimes it does not make sense to allow the user to interact with a control in the current context, for example, to
press a Paste button when the clipboard is empty. At these times, make the control insensitive to minimize the risk
of user error. While a control is insensitive, it will appear dimmed and will not be able to receive the focus, although
assistive technologies like screenreaders will still be able to detect and report it.

It is usually better to make a control insensitive than to hide it altogether. This way, the user can learn about func-
tionality they may be able to use later, even if it is not available right now.

Figure 6.1. Two check boxes: sensitive (top) and insensitive (bottom)

3.1. Locked Controls

In a network-managed environment, like a computer lab, system administrators usually want to "lock down" the val-
ues of certain settings, or remove them from the user interface altogether. This makes it easier for them to trou-
bleshoot any problems that their users may encounter. In GNOME, the correct way for the system administrator to
do this is by restricting write access to the GConf keys corresponding to those settings.

When you are designing your application, consider which settings a system administrator might want to make un-
available to users. These may typically include:

• Settings that, if set wrongly, could prevent the application from functioning at all. For example, proxy settings in
a network application.

• Settings that could refer to networked resources. For example, the Templates directory in an office application,
where shared stationery such as fax cover sheets might be stored.
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• Settings that customize the user interface, other than those required for accessibility. For example, certain menu,
keyboard or toolbar customization options.

Your application needs to decide every time these controls are displayed whether or not they are available for edit-
ing, depending on the writeable state of the GConf key that holds its value. In the simplest case, your code for each
control could look like that in the example below.

Example 6.1. Sample code fragment showing how to make a GConf-locked control
insensitive

if (!gconf_key_is_writable (http_proxy))
gtk_widget_set_sensitive (http_proxy_field, FALSE);

Include a section for system administrators in your user guide, explaining which settings they can lock, and their
corresponding GConf keys.

Explain to the user why these controls cannot be edited at this time. You can do this with static text, tooltips or on-
line help, depending on the situation. For example:

Figure 6.2. Example of a dialog with locked controls

Note that although they cannot be edited, the settings are still visible and selectable, and may be copied to the clip-
board.
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4. Text Entry Fields
Text entry fields are used for entering one or more lines of plain text. In GTK 2, the GtkEntry
[http://developer.gnome.org/doc/API/2.0/gtk/gtkentry.html] control is used for single-line text entry, and Gtk-
TextView [http://developer.gnome.org/doc/API/2.0/gtk/gtktextview.html] for multiple-line text entry.

Figure 6.3. Single and multi-line entry fields

Guidelines

• Label the entry field with a text label above it or to its left, using sentence capitalization. Provide an access key
in the label that allows the user to give focus directly to the entry field.

• Right-justify the contents of entry fields that are used only for numeric entry, unless the convention in the user's
locale demands otherwise. This is useful in windows where the user might want to compare two numerical val-
ues in the same column of controls. In this case, ensure the right edges of the relevant controls are also aligned.

• When the user gives focus to an entry field using the keyboard, place the text cursor at the end of the existing
text and highlight its contents (but don't overwrite the existing PRIMARY clipboard selection). This makes it
easy to immediately overtype or append new text, the two most common operations performed on entry fields.

• Size text entry fields according to the likely size of the input. This gives a useful visual cue to the amount of in-
put expected, and breaks up the dialog making it easier to scan. Don't make all the fields in the dialog the same
width just to make everything line up nicely.

• In an instant-apply property or preference window, validate the contents of the entry field when it loses focus,
not after each keypress.

• Provide a static text prompt for text boxes that require input in a particular format or in a particular unit of mea-
surement. For example:

Figure 6.4. Text entry field with static text prompt

• Where possible, provide an additional or alternative control that limits the required input to the valid range. For
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example, provide a spinbox or slider if the required input is one of a fixed range of integers, or provide access to
a GtkCalendar [http://developer.gnome.org/doc/API/2.0/gtk/gtkcalendar.html] control if the user has to enter a
valid date:

Figure 6.5. Text entry field requiring a date as input, with a button beside it to pop up a
GtkCalendar control to simplify the task

This is less error-prone than expecting the user to format their text input in some arbitrary format. You may still
want to provide the entry field control as well, however, for expert users who are familiar with the required for-
mat.

• If you implement an entry field that accepts only keystrokes valid in the task context, such as digits, play the sys-
tem warning beep when the user tries to type an invalid character. If the user types three invalid characters in a
row, display an alert that explains the valid inputs for that textfield.

4.1. Behavior of Return key

Normally, pressing Return in a dialog should activate the dialog's default button, unless the focused control uses
Return for its own purposes. You should therefore set the activates-default
[http://developer.gnome.org/doc/API/2.0/gtk/gtkentry.html#GTK-ENTRY-SET-ACTIVATES-DEFAULT] property
of most entry fields to TRUE. (Note that GtkTextView does not have such a setting— pressing Return always in-
serts a new line.).

However, if your dialog contains several entry fields that are usually filled out in order, for example Name, Address
and Telephone Number, consider setting the activates-default property on those entry fields to FALSE.
Pressing Return should then move focus on to the next control instead. Doing this will help prevent the user from
accidentally closing the window before they have entered all the information they wanted to.

As a further safeguard, remember not to set the default button in a dialog until the minimum amount of required in-
formation has been entered, for example, both a username and a password in a login dialog. Again, in this case you
should move focus to the next control when the user presses Return, rather than just ignoring the keypress.

If you need to provide a keyboard shortcut that activates the default button while a GtkTextView control has focus,
use Ctrl-Return.

4.2. Behavior of Tab key

Normally, pressing Tab in a single-line entry field should move focus to the next control, and in a multi-line entry
field it should insert a tab character. Pressing Ctrl-Tab in a multi-line entry field should move focus to the next con-
trol.

If you need to provide a keyboard shortcut that inserts a tab character into a single line entry field, use Ctrl-Tab.
You are unlikely to find many situations where this is useful, however.

5. Spin Boxes
A spin box is a text box that accepts a range of values. It incorporates two arrow buttons that allow the user to in-
crease or decrease the current value by a fixed amount.
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Figure 6.6. Example of a spin box

Guidelines

• Use spin boxes for numerical input only. Use a list or option menu when you need the user to select from fixed
data sets of other types.

• Use a spin box if the numerical value is meaningful or useful for the user to know, and the valid input range is
unlimited or fixed at one end only. For example, a control for specifying the number of iterations of some action,
or a timeout value. If the range is fixed at both ends, or the numerical values are arbitrary (for example, a volume
control), use a slider control instead.

• Label the spin box with a text label above it or to its left, using sentence capitalization. Provide an access key in
the label that allows the user to give focus directly to the spin box.

• Right-justify the contents of spin boxes, unless the convention in the user's locale demands otherwise. This is
useful in windows where the user might want to compare two numerical values in the same column of controls.
In this case, ensure the right edges of the relevant controls are also aligned.

6. Sliders
A slider allows the user to quickly select a value from a fixed, ordered range, or to increase or decrease the current
value. The control looks like the type of slider that you might find on an audio mixing desk or a hi-fi's graphic
equalizer. In gtk, you implement a slider using the GtkHScale or GtkVScale controls, for horizontal or vertical slid-
ers respectively.

Figure 6.7. A simple slider control

Guidelines

• Use a slider when:

• adjusting the value relative to its current value is more important than choosing an absolute value. For exam-
ple, a volume control: the average user will usually think about turning the volume up or down to make a
sound louder or quieter, rather than setting the peak output to a specific decibel value.

• it is useful for the user to control the rate of change of the value in real time. For example, to monitor the ef-
fects of a color change in a live preview window as they drag the RGB sliders.

• Label the slider with a text label above it or to its left, using sentence capitalization. Provide an access key in the
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label that allows the user to give focus directly to the slider.

• Mark significant values along the length of the slider with text or tick marks. For example the left, right and cen-
ter points on an audio balance control in Figure 6.7.

• For large ranges of integers (more than about 20), and for ranges of floating point numbers, consider providing a
text box or spin box that is linked to the slider's value. This allows the user to quickly set or fine-tune the setting
more easily than they could with the slider control alone.

Figure 6.8. Slider controls with linked spin boxes

7. Buttons
A button initiates an action when the user clicks it.

Figure 6.9. Typical buttons in a modal dialog

Guidelines

• Label all buttons with imperative verbs, using header capitalization. For example, Save, Sort or Update Now.
Provide an access key in the label that allows the user to directly activate the button from the keyboard.

• After pressing a button, the user should expect to see the result of their action within 1 second. For example,
closing the window or opening another. See Chapter 7 for guidance on what to do if your application cannot re-
spond this quickly.

• Use an ellipsis (...) at the end of the label if the action requires further input from the user before it can be carried
out. For example, Save As... or Find.... Do not add an ellipsis to commands like Properties, Preferences, or Set-
tings, as these open windows that do not require further input.

• Once a dialog is displayed, do not change its default button from one button to another. You may add or remove
default status from the same button if it helps prevent user error, however. Changing the default from one button
to another can be confusing and inefficent, especially for users relying on assistive technologies.
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• If your button can display text, an icon, or both, choose which label to display at runtime according to the user's
preference in the GNOME Menus and Toolbars Preferences dialog. However, you may over-ride this preference
when there is no suitable icon to describe the button's action graphically, for example.

• Do not use more than one or two different widths of button in the same window, and make all of them the same
height. This will help give a pleasing uniform visual appearance to your window that makes it easier to use.

• Do not assign actions to double-clicking or right-clicking a button. Users are unlikely to discover these actions,
and if they do, it will distort their expectations of other buttons on the desktop.

• Make invalid buttons insensitive, rather than popping up an error message when the user clicks them.

In a dialog, one button may be made the default button, which is shown with a different border and is activated by
pressing Return. Often this will be the OK or equivalent button. However, if pressing this button by mistake could
cause a loss of data, do not set a default button for the window. Do not make Cancel the default button instead. See
Section 3.2 for more information.

If it does not make sense to have a default button until several fields in the dialog have been correctly
completed—for example, both the Username and Password fields in a login dialog—do not set the default button
until they have both been completed.

8. Check Boxes
Check boxes are used to show or change a setting. Its two states, set and unset, are shown by the presence or absence
of a checkmark in the labelled box.

Figure 6.10. A typical group of check boxes

Guidelines

• Do not initiate an action when the user clicks a check box. However, if used in an instant-apply property or pref-
erence window, update the setting represented by the check box immediately.

• Clicking a check box should not affect the values of any other controls. It may sensitize, insensitize, hide or
show other controls, however.

• If toggling a check box affects the sensitivity of other controls, place the check box immediately above or to the
left of the controls that it affects. This helps to indicate that the controls are dependent on the state of the check
box.

• Use sentence capitalization for check box labels, for example Use custom font.
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• Label check boxes to clearly indicate the effects of both their checked and unchecked states, for example, Show
icons in menus. Where this proves difficult, consider using two radio buttons instead so both states can be given
labels. For example:

Figure 6.11. Ambiguous check box (top), radio buttons work better in this case (bottom)

The single check box in this example is ambiguous, as it is not clear where the "progress indicator" will go if the
box is unchecked. Two radio buttons are better in this case, as they make the options clear.

• Provide an access key in all check box labels that allows the user to set or unset the check box directly from the
keyboard.

• If the check box represents a setting in a multiple selection that is set for some objects in the selection and unset
for others, show the check box in its mixed state. For example:

Figure 6.12. Check boxes (right) showing properties for a multiple selection of files in
Nautilus (left)

In this example, both selected files are hidden (since their filenames start with "."), and the emblems on their
icons show that neither file is writeable, but one is readable. The Readable check box is therefore shown in its
mixed state. .

When a check box is in its mixed state:

• clicking the box once should check the box, applying that setting (when confirmed) to all the selected objects

• clicking the box a second time should uncheck the box, removing that setting (when confirmed) to all the se-
lected objects

• clicking the box a third time should return the box to its mixed state, restoring each selected object's original
value for that setting (when confirmed)

• Label a group of check boxes with a descriptive heading above or to the left of the group.

Chapter 6. Controls

69



• Use a frame around the group if necessary, but remember that blank space often works just as well and results in
a less visually-cluttered dialog.

• Do not place more than about eight check boxes under the same group heading. If you need more than eight, try
to use blank space, heading labels or frames to divide them into smaller groups. Otherwise, consider using a
check box list instead— but you probably also need to think about how to simplify your user interface.

• Try to align groups of check boxes vertically rather than horizontally, as this makes them easier to scan visually.
Use horizontal or rectangular alignments only if they greatly improve the layout of the window.

9. Radio Buttons
Radio buttons are used in groups to select from a mutually exclusive set of options. Only one radio button within a
group may be set at any one time. As with check boxes, do not use radio buttons to initiate actions.

Figure 6.13. A typical group of radio buttons

Guidelines

• Only use radio buttons in groups of at least two, never use a single radio button on its own. To represent a single
setting, use a check box or two radio buttons, one for each state.

• Exactly one radio button should be set in the group at all times. The only exception is when the group is showing
the properties of a multiple selection, when one or more of the buttons may be in their mixed state.

• Do not initiate an action when the user clicks a radio button. However, if used in an instant-apply property or
preference window, update the setting represented by the radio button immediately.

• Clicking a radio button should not affect the values of any other controls. It may sensitize, insensitize, hide or
show other controls, however.

• If toggling a radio button affects the sensitivity of other controls, place the radio button immediately to the left of
the controls that it affects. This helps to indicate that the controls are dependent on the state of the radio button.

• Use sentence capitalization for radio button labels, for example Switched movement. Provide an access key in
the label that allows the user to set the radio button directly from the keyboard.

• If the radio button represents a setting in a multiple selection that is set for some objects in the selection and un-
set for others, show the radio button in its mixed state. For example:

Figure 6.14. Radio buttons (right) showing properties for a multiple selection of shapes
in a drawing application (left)
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. In this situation, clicking any radio button in the group should set the clicked button, and unset all the others.
Thereafter, the group should behave like a normal radio button group— there is no way to reset a radio button to
its mixed state by clicking on it. Provide a Reset button or equivalent in the window that allows the previous
mixed settings to be restored without closing the window or cancelling the dialog.

• Label a group of radio buttons with a descriptive heading above or to the left of the group.

• Use a frame around the group if necessary, but remember that blank space often works just as well and results in
a less visually-cluttered dialog.

• Do not place more than about eight radio buttons under the same group heading. If you need more than eight,
consider using a single-selection list instead— but you probably also need to think about how to simplify your
user interface.

• Try to align groups of radio buttons vertically rather than horizontally, as this makes them easier to scan visu-
ally. Use horizontal or rectangular alignments only if they greatly improve the layout of the window.

10. Toggle Buttons
Toggle buttons look similar to regular Buttons, but are used to show or change a state rather than initiate an action.
A toggle button's two states, set and unset, are shown by its appearing "pushed in" or "popped out" respectively.

Figure 6.15. A typical group of toggle buttons

Guidelines

• Do not use groups of toggle buttons in dialogs unless space constraints force you to do so, or you need to pro-
vide consistency with a toolbar in your application. Check boxes or radio buttons are usually preferable, as they
allow more descriptive labels and are less easily-confused with other types of control.

• Only use toggle buttons in groups, so they are not mistaken for regular buttons. Make the group behave like ei-
ther a group of check boxes or a group of radio buttons, as required.

• Provide an access key in the label of all toggle buttons that allows the user to set or unset the button directly
from the keyboard.
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• Label a group of toggle buttons with a descriptive heading above or to the left of the group, as you would with a
group of check boxes or radio buttons.

• Use a frame around the group of buttons if necessary, but remember that blank space often works just as well
and results in a less visually-cluttered dialog.

• Try to align groups of toggle buttons horizontally rather than vertically. This is how toggle buttons normally ap-
pear on a toolbar, so the user will be more familiar with this arrangement.

• Do not leave any space between toggle buttons in a group, otherwise they may look unrelated or may be mis-
taken for regular buttons.

• Use header capitalization for toggle button labels, for example No Wallpaper, Embossed Logo.

• If your toggle button can display text, an icon, or both, choose which to display at runtime according to the user's
setting in the GNOME Menus and Toolbars preference dialog.

• Use the same text or graphical label for a toggle button whether it is set or unset.

• If the toggle button represents a setting in a multiple selection that is set for some objects in the selection and un-
set for others, show the button in its mixed state. For example:

Figure 6.16. Toggle buttons (right) showing properties for a multiple selection of shapes
in a drawing application (left)

11. Option Menus
Option menus are used to select from a mutually exclusive set of options. They can be useful when there is insuffi-
cient space in a window to use a group of radio buttons or a single-selection list, with which they are functionally
equivalent.

Figure 6.17. An option menu showing current selection (left) and the list of available
choices when clicked on (right)
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Recommendations:

• Do not use option menus with fewer than three items, or more than about ten. To offer a choice of two options,
use radio buttons or toggle buttons. To offer a choice of more than ten options, use a list.

• Do not initiate an action when the user selects an item from an option menu. However, if used in an instant-ap-
ply property or preference window, update the setting that the menu represents immediately.

• Selecting an item from an option menu should not affect the values of any other controls. It may sensitize, insen-
sitize, hide or show other controls, however.

• Label the option menu with a text label above it or to its left, using sentence capitalization. Provide an access
key in the label that allows the user to give focus directly to the option menu.

• Use sentence capitalization for option menu items, for example Switched movement

• Assign an access key to every option menu item. Ensure each access key is unique within the enclosing window
or dialog, not just within the menu.

• Do not assign shortcut keys to option menu items by default. The user may assign their own shortcut keys in the
usual way if they wish, however.

• Do not use an option menu in a situation where it may have to show a property of a multiple selection, as option
menus have no concept of mixed state. Use a group of radio or toggle buttons instead, as these can show set, un-
set or mixed states.

You should normally use radio buttons or a list instead of option menus, as those controls present all the available
options at once without any further interaction. However, option menus may be preferable in a window where:

• there is little available space

• the list of options may change over time

• the contents of the hidden part of the menu are obvious from its label and the one selected item. For example, if
you have an option menu labelled "Month:" with the item "January" selected, the user might reasonably infer
that the menu contains the 12 months of the year without having to look.

Option menus can also be useful on toolbars, to replace a group of several mutually-exclusive toggle buttons.

12. Combo Boxes
Combo boxes combine a text entry field and a dropdown list of pre-defined values. Selecting one of the pre-defined
values sets the entry field to that value.

Figure 6.18. A combo box before and after its dropdown list is displayed
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Guidelines

• Only use a combo box instead of a list, option menu or radio button group when it is important that the user be
able to enter a new value that is not already amongst the list of pre-defined choices.

• Do not initiate an action when the user selects an item from the list in a combo box. If used in an instant-apply
property or preference window, update the setting represented by the combo box immediately if possible. If this
isn't possible due to the contents of the entry field being invalid while the user is still typing into it, update the
related setting when the combo box loses focus instead.

• If the user types a value into the combo box that is not already in the drop-down list, add it to the list when the
combo box loses focus so they can select it next time.

• Interpret user input into a combo box in a case-insensitive way. For example, if the user types blue, Blue and
BLUE into the same combo box on different occasions, only store one of these in the combo's dropdown list, un-
less your application makes a distinction between the different forms (which is usually a bad idea).

• Label the combo box with a text label above it or to its left, using sentence capitalization. Provide an access key
in the label that allows the user to give focus directly to the combo box.

• Use sentence capitalization for the dropdown list items, for example Switched movement.

13. Lists
A list control allows the user to inspect, manipulate or select from a list of items. Lists may have one or more
columns, and contain text, graphics, simple controls, or a combination of all three.

Figure 6.19. A simple two column list
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Guidelines

• Always give list controls a label, positioned above or to the left of the list, in sentence capitalization. Provide an
access key in the label that allows the user to give focus directly to the list.

• Make the list control large enough that it can show at least four items at a time without scrolling. For lists of ten
or more items, increase this minimum size as appropriate.

• If the list appears in a dialog or utility window, consider making the window and the list within it resizable so
that the user can choose how many list items are visible at a time without scrolling. Each time the user opens this
dialog, set its dimensions to those that the user last resized it to.

• Do not use lists with less than about five items, unless the number of items may increase over time. Use check
boxes, radio buttons or an option menu if there are fewer items.

• Only use column headers when:

• the list has more than one column, or

• the list has only one column, but the user may wish to re-order the list. (This is rarely useful with single col-
umn lists).

In most other situations, column headers take up unnecessary space, and the extra label adds visual clutter.

• Always label column headers when used. If the column is too narrow for a sensible label, provide a tooltip for
the column instead. Apart from its obvious use, this will help ensure that assistive technologies can describe the
use of the column to visually impaired users.

• Consider using a check box list for multiple-selection lists, as these make it more obvious that multiple selection
is possible:
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Figure 6.20. A simple check box list

If you do this, you should normally set the list control itself to be single-selection, but this depends on the partic-
ular task for which it will be used.

• For multiple selection lists, show the number of items currently selected in a static text label below the list, for
example, Names selected: 3. Such a label also makes it more obvious that multiple selection is possible.

• Consider providing Select All and Deselect All buttons beside multiple selection lists, if appropriate.

14. Trees
A tree control allows the user to inspect, manipulate or select from a hierarchichal list of items. Trees may have one
or more columns, and contain text, graphics, simple controls, or a combination of all three.

Figure 6.21. A simple tree control with one level of hierarchy

Guidelines

• Always give tree controls a label, positioned above or to the left of the tree, in sentence capitalization. Provide
an access key in the label that allows the user to give focus directly to the tree.

• Use column headers when:

• the tree has more than one column

• the tree has only one column, but the user may wish to re-order the tree. This should rarely be true of single
column trees.
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In most other situations, column headers take up unnecessary space, and the extra label adds visual clutter.

• Always label column headers when used. If the column is too narrow for a sensible label, provide a tooltip for
the column instead. Apart from its obvious use, this will help ensure that assistive technologies can describe the
use of the column to visually impaired users.

• Consider using a check box tree for multiple-selection trees, as these make it more obvious that multiple selec-
tion is possible:

Figure 6.22. A simple check box tree

If you do this, you should normally set the tree control itself to be single-selection, but this depends on the par-
ticular task for which it will be used.

• For multiple selection trees, show the number of items currently selected in a static text label below the tree, for
example, Names selected: 3. Such a label also makes it more obvious that multiple selection is possible.

• Consider providing Select All and Deselect All buttons beside multiple selection trees, if appropriate to the task.

15. Tabbed Notebooks
A tabbed notebook control is a convenient way of presenting related information in the same window, without hav-
ing to display it all at the same time. It is analagous to the divider tabs in a ring binder or a file cabinet.

Figure 6.23. A typical notebook control with four tabs

Guidelines
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• Do not put too many pages in the same notebook. If you cannot see all the tabs without scrolling or splitting
them into multiple rows, you are probably using too many and should use a list control instead. See the example
below.

• Label tabs with header capitalization, and use nouns rather than verbs, for example Font or Alignment. Try to
keep all labels in a notebook the same general length.

• Do not assign access keys to tab labels, as this means you cannot use those access keys for any control on any of
the tabs. Assign an access key to every other control on each page, however.

• Do not design a notebook such that changing controls on one page affects the controls on any other page. Users
are unlikely to discover such dependencies.

• If a control affects only one notebook page, place it on that notebook page. If it affects every page in the note-
book, place it outside the notebook control, for example beside the window's OK and Cancel buttons.

• Use tabs that are proportional to the width of their labels. Don't just set all the tabs to the same width, as this
makes them harder to scan visually, and limits the number of tabs you can fit into the notebook without
scrolling. For example:

Figure 6.24. Fixed- and proportional-width tabs (preferred)

• Although the contents of each page in a notebook will take up a different amount of space, do not use larger than
normal spacing around the controls in the "emptier" pages, and do not center the controls on the page.

• If your tab labels include icons, choose whether or not to show the icons at runtime based on the user's prefer-
ence in the GNOME Menus and Toolbars desktop preferences dialog. Always show the text part of the label,
however.

If you have more than about six tabs in a notebook, use a list control instead of tabs to switch between the pages of
controls. For example:

Figure 6.25. Use of list control where there would be too many tabs to fit comfortably in a
notebook
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As in this example, place the list control on the left-hand side of the window, with the dynamic portion of the win-
dow immediately to its right.

16. Progress Bars
Progress bars are visual indicators of the progress of a task being carried out by the application.

There are two types of progress indicator: "measured" progress, which shows what proportion of the task has been
completed, and "indeterminate" progress, which only shows that the application is busy. The progress bar control is
used to show measured progress. (For more information on indeterminate progress indicators, see Section 4.2.1.4.)

Figure 6.26. A measured ("time remaining") progress dialog

There are three styles of measured progress indicator in which you would typically use a progress bar control:

• Time remaining

• Proportion completed

• Typical time
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Always use a measured progress bar when the length of a task can be precisely or approximately predicted. Other-
wise, use an indeterminate progress indicator or a progress checklist.

See Chapter 7 for more details on when and how to use progress bars.

17. Status Bars
A status bar is an area at the bottom of a window that can be used to display brief information about the status of the
application.

Figure 6.27. A simple status bar

Guidelines

• Use status bars only in application or document windows. Do not use them in dialogs, alerts or other secondary
windows.

• Only place a status bar along the bottom of a window.

• Only use status bars to display non-critical information. This might include:

• general information about the document or application. For example, current connection status in a network
application, or the size of the current document in a text editor.

• information about the task the user is currently performing. For example, while using the selection tool in a
drawing application, "Hold Shift to extend the selection"

• progress of a background operation. For example, "Sending to printer", "Printing page 10 of 20", "Printing
Complete".

• a description of the control or area of the window under the mouse pointer. For example, "Drop files here to
upload them"

Remember that status bars are normally in the user's peripheral vision, and can even be turned off altogether us-
ing the application's View->Status Bar menu item. The user may therefore never see anything you display there,
unless they know when and where to look for it.

• When there is no interesting status to report, leave a status bar panel blank rather than displaying something un-
informative like "Ready". This way, when something interesting does appear in the status bar, the user is more
likely to notice it.

• If you want to make all or part of your status bar interactive, use the following conventions:
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• Inlaid appearance for areas that respond to a double click

• Flat appearance for areas that are not interactive

In Figure 6.28, the appearance indicates that the left area would respond to a double click (perhaps by saving the
document), and the progress indicator on the right is non-interactive.

Figure 6.28. An interactive status bar

Ensure that double-clicking in the status area does not provide any functionality that is not also available in the
main application menu bar, or by some other accessible means.

18. Frames and Separators
A frame is a box with a title that you can draw around controls to organise them into functional groups. A separator
is a single horizontal or vertical line that you can use to divide windows into functional groups.

Frames with a border around their perimeter have traditionally been used for denoting groups of related controls.
This is advantageous because it physically seperates disimilar controls, and also avoids repitition of the frame's label
in individual member control labels. Unfortunately, they add visual noise that can both make a window appear more
complex than it really is, and reduce the ability to quickly scan window elements.

Rather than using bordered frames, use frames without borders, bold labels to make the categories stand out, and in-
dented contents. This, combined with good layout and spacing, is usually a better alternative to bordered frames.

Figure 6.29. Preferred frame style, using bold labels, spacing and indentation
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Figure 6.30. Traditional frame style, using borders (deprecated)
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See Section 2.3 for technical details on implementing the preferred frame style in gtk.

Guidelines

• Before you add a frame with a visible border or separator to any window, consider carefully if you really need it.
It is usually better to do without, if the groups can be separated by space alone. Do not use frames and separators
to compensate for poor control layout or alignnment.

• Do not mix framed and unframed groups in the same window.

• Do not nest one frame inside another. This results in visual clutter.

Chapter 6. Controls

83



Chapter 7. Feedback

1. Characteristics of Responsive Applications
Although highly responsive applications can differ widely from one another, they share the following characteris-
tics:

• They keep up with users, even when they cannot fulfill users' requests immediately.

• They handle queued requests as users would expect, discarding requests that are no longer relevant and reorder-
ing requests according to users' probable priorities.

• They let users do other work while long operations proceed to completion— especially operations not requested
by users— such as reclaiming unused memory or other "housekeeping" operations.

• They provide enough feedback for users to understand what they are doing, and organize feedback according to
users' abilities to comprehend and react to it.

• They let users know when processing is in progress.

• They let users know or estimate how long lengthy operations will take.

• They let users set the pace of work, when possible, and they let users stop requested tasks that have started but
not finished.

Highly responsive applications put users in control by quickly acknowledging each user request, by providing con-
tinuous feedback about progress toward fulfilling each request, and by letting users complete tasks without unac-
ceptable delays.

Even applications with attractive, intuitive user interfaces can lack responsiveness. Typically, unresponsive applica-
tions have at least one of the following problems:

• They provide late feedback— or no feedback— for users' requests, leaving users wondering what the application
has done or is doing.

• When performing extended operations, they prevent users from doing other work or cancelling the extended op-
eration.

• They fail to display estimates of how long extended operations will last, forcing users to wait for unpredictable
periods.

• They ignore users' requests while doing unrequested "housekeeping", forcing users to wait at unpredictable
times— often without feedback.

You can sometimes possible to improve an application's responsiveness without speeding up the application's code.
For tips on how to make such improvements, see Section 3.

2. Acceptable Response Times
Some user interface events require shorter response delays than others. For example, an application's response to a
user's mouse click or key press needs to be much faster than its response to a request to save a file. The table below
shows the maximum acceptable response delay for typical interface events.
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Table 7.1. Maximum acceptable response times for typical events

UI Event Maximum Acceptable Response Time

Mouse click, pointer movement, window movement or
resizing, keypress, button press, drawing gesture, other
UI input event involving hand-eye co-ordination

0.1 second

Displaying progress indicators, completing ordinary user
commands (e.g. closing a window), completing back-
ground tasks (e.g. reformatting a table)

1.0 second

Displaying a graph or anything else a typical user would
expect to take time (e.g. displaying a new list of all a
company's financial transactions for an accounting pe-
riod)

10.0 seconds

Accepting and processing all user input to any task 10.0 seconds

Make each response delay in your application as short as possible, unless users need time to see the displayed infor-
mation before it is erased. The acceptable response delay for each event is based on a typical user's sense that the
event is a logical point at which to stop or pause. The greater that sense is, the more willingly the user will wait for a
response. Verify that your application responds to users' requests within the limits listed in the table above. If your
application cannot respond within those limits, it probably has one or more general problems caused by a particular
algorithm or module.

Recommendations:

• Verify that your application provides feedback within 100 milliseconds (0.1 second) after each key press, move-
ment of the mouse, or other physical input from the user.

• Verify that your application provides feedback within 100 milliseconds (0.1 second) after each change in the
state of controls that react to input from the user— for example, displaying menus or indicating drop targets.

• Verify that your application takes no longer than 1 second to display each progress indicator, complete each or-
dinary user command, or complete each background task.

• Verify that your application takes no longer than 10 seconds to accept and process all user input to any in-
task—cluding user input to each step of a multistep task, such as a wizard.

3. Responding to User Requests
If your application takes too long to respond, users will become frustrated. Use these techniques to improve the re-
sponsiveness of your application.

Recommendations:

• Display feedback as soon as possible.

• If you cannot display all the information that a user has requested, display the most important information first.

• Save time by displaying approximate results while calculating finished results.

• If users are likely to repeat a time-consuming command in rapid succession, save time by faking the command's
effects instead of repeatedly processing the command. For example, if a user adds several rows to a table stored
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in a database, you might display each new row immediately but delay actually creating each new row in the
database until the user finished adding all the rows.

• Work ahead. Prepare to perform the command that is most likely to follow the current command. That is, use
idle time to anticipate users' probable next requests. For example, as the user of an email application reads the
currently displayed new message, the application might prepare to display the next new message.

• Use background processing. Perform less important tasks —such as housekeeping— in the background, enabling
users to continue working.

• Delay work that is not urgent. Perform it later, when more time is available.

• Discard unnecessary operations. For example, to move back several pages in a web browser, a user might click
the browser's Back button several times in rapid succession. To display the final requested page more quickly,
the browser might not display the pages visited between the current page and that final page.

• Use dynamic time management. At run time, change how your application prioritizes user input and other pro-
cessing, based on the application's current state. For example, if a user is typing text in one word-processing doc-
ument while printing another, the word-processing application might delay the printing task if the user shifts to
an editing task (such as cutting and pasting text) that requires greater resources.

• In your application, display an estimate of how long each lengthy operation will take.

• If a command might take longer than 5 seconds to complete its work on an object, allow users to interact
with any parts of the object and parts of the application that are not directly affected by the command.

• If a command provides lengthy output, show partial results as they become available. Scroll the results (if
necessary) until the user moves input focus to a component (e.g. a scrollbar or text area) involved in the
scrolling.

4. Types of Visual Feedback
You can use two types of visual feedback for operations in your application— pointer feedback and progress anima-
tions.

4.1. Pointer Feedback

Pointer feedback changes the shape of the pointer. For example, a busy pointer indicates that an operation is in
progress and that the user cannot do other tasks. A busy-interactive pointer indicates that an operation is in progress
but the window is still interactive.

Figure 7.1. Busy pointer (left) and Busy-Interactive pointer (right)

4.2. Progress Animations

Progress animations show either how much of an operation is complete, or only that an operation is ongoing. Nor-
mally, these take the form of either a progress bar or a progress checklist.
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Recommendations:

• When displaying a progress animation, open it as soon as possible after you know it is required, and close it au-
tomatically as soon as the associated operation is complete.

• Use a measured-progress bar if your application can estimate either how long the operation will take, or what
proportion of the operation is complete.

• If your application can make neither estimate, and the operation only has one step, use an indeterminate-progress
bar. For operations with two or more steps, use a progress checklist that dynamically displays a check mark for
each completed step.

4.2.1. Progress Bars

You can use two main types of progress bars in your application— measured-progress bars and indeterminate-
progress bars. There are three types of measured progress bars, but only one type of indeterminate progress bar,
which are described in the following sections.

Ensure that a measured-progress bar measures an operation's total time or total work, not just that of a single step.
An exception is a progress bar that measures the total time or work of the current step in a progress checklist.

4.2.1.1. Time-remaining Progress Indicator

An animation consisting of a bar whose changing length indicates how much time remains in an operation, and text
stating how much time remains before the operation will be complete. Time-remaining bars are the most useful type
of progress bar.

Figure 7.2. A simple 'time remaining' progress dialog

Use a time-remaining bar if your application will display an initial estimate of an operation's remaining time and
then periodically display updated estimates. Each updated estimate should be based on changes that have occurred
and that will cause the operation to finish more quickly or more slowly. If the operation will finish more slowly,
your application can display an updated estimate that is greater than the estimate previously displayed.

4.2.1.2. Proportion-completed Progress Indicator

A bar whose changing length represents the completed proportion— typically a percentage— of an operation's total
units of work. Proportion-completed bars are less useful than time-remaining bars but more useful than typical-time
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bars.

Figure 7.3. A simple 'proportion completed' progress dialog

Use a proportion-completed bar if your application will estimate an operation's duration by counting the units of
work completed so far, without regard for changes that might affect how quickly the remaining units will be com-
pleted. If the operation will process a known number of objects or a set of objects whose total size is known, equate
the length of the bar to the total number of units of work that the operation will perform. At least every four seconds,
update the bar to show how much of the operation is complete.

4.2.1.3. Typical-time Progress Indicator

A bar whose changing length indicates how much time remains if an operation takes as long as it typically does.
Typical-time bars are the least precise type of measured-progress bar, but they are more useful than indeterminate-
progress bars.

Figure 7.4. A simple 'typical time remaining' progress dialog

For some operations, you cannot estimate the time remaining or the proportion of work completed. However, if you
can estimate the typical time for that operation, you can provide feedback with a typical-time bar.

If your application overestimates the completed amount of work, the length of the bar can indicate "almost complete
until the operation is complete. If your application underestimates how much work is complete, the application can
fill the remaining portion of the bar when the operation is complete.
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4.2.1.4. Indeterminate-progress indicator

An animated bar indicating only that an operation is ongoing, not how long it will take. One example is the throb-
"ber" in a web browser. Indeterminate-progress bars are the least precise type of progress bar.

Figure 7.5. A simple 'indeterminate time' progress dialog; the slider moves from
left-to-right and back again until the operation is complete

Use an indeterminate-progress bar to provide feedback only for operations whose duration you cannot estimate at
all.

4.2.2. Progress Checklists

A progress checklist shows the sequence of stages in an operation but does not display time estimates for those
stages.

Figure 7.6. A simple progress checklist dialog

When providing feedback with a progress checklist, you can include a measured-progress bar directly below the
checklist. The bar measures the progress of the current step in the progress checklist.
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Figure 7.7. A progress checklist dialog with progress bar for current step

5. Choosing Appropriate Feedback
To determine which type of visual feedback to provide for a particular operation, consider these factors:

• Whether your application can provide an estimate of the operation's progress.

• Whether the operation blocks the user from issuing further commands in your application.

• Whether your application has a dedicated space, such as a status bar, for indicating the status of operations.

The table below shows which type of feedback to provide for operations that usually take at least 1 second to finish.
In the "Appropriate Feedback" column, "Internal progress animations" means progress animations displayed in an
application's dedicated status area, and "External progress animations" means progress animations displayed some-
where other than in a dedicated status area— typically, in an alert box.

Table 7.2. Visual feedback types for operations that take at least 1 second

Typical Duration > 5 sec-
onds?

User blocked from issuing
further commands?

Application has dedicated
status area?

Appropriate feedback

Yes Yes Yes Internal animation plus
pointer feedback

Yes Yes No Pointer feedback

Yes No Yes Internal animation

No Yes Yes Internal animation plus
pointer feedback
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Typical Duration > 5 sec-
onds?

User blocked from issuing
further commands?

Application has dedicated
status area?

Appropriate feedback

No Yes No External animation plus
pointer feedback

No No Yes Internal animation

No No No External animation

Recommendations:

• Use a busy pointer whenever users are blocked from interaction with your application for 1 second or longer.
Display the busy pointer less than 1 second after the operation begins.

• If a command will likely take 10 seconds or longer to finish, provide a Stop or Cancel button that lets users ter-
minate the command's processing even if your application cannot undo the command's effects. See Section 6.

• When using an external animation, leave the window containing the animation on-screen for at least 1 second af-
ter the operation has completed, with a successful completion message. Change the Stop or Cancel button to an
OK button during this period— pressing this button should close the window immediately.

6. Allowing Interruptions
Users sometimes need to stop a command— for example, because it is taking too long. Your application should let
users stop commands in progress, even if stopping a command cannot undo or "roll back" all the command's effects.

Recommendations

• Place a Stop or Cancel button near the progress animation for the interruptable command.

• Label the button Cancel if the whole operation can be cleanly abandoned with no side effects, leaving the system
in the state it was in prior to the operation beginning. Terminate the command immediately when the user
presses this button.

• Label the button Stop if the command can be interrupted, but its effects up to that point cannot (or should not) be
reversed. When the user presses this button, open an alert box that warns of the potential side effects of stopping
the command. The alert box should have only two buttons: one for continuing the command's processing, and
one for immediately terminating it.

Alternatively, you can place the Stop or Cancel button near the control with which the user issued the command that
needs to be stopped. Place the button here only if:

• There is no progress animation for the command, or

• The progress animation is in a window's status area or in another location that lacks space for a Stop or Cancel
button.

In the alert box that appears after pressing a Stop button, ensure the message and button labels in the alert box are
specific and precise. Ambiguous button labels can cause users to terminate or continue a command unintentionally.
For example, use:

Continue deleting files? [Continue Deleting] [Stop Deleting]

rather than
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Operation interrupted, continue? [Yes] [No]

since in the latter example, it is not clear whether pressing Yes would continue the operation or continue the inter-
ruption (i.e. cancel the operation).
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Chapter 8. Visual Design
Visual design is not just about making your application look pretty. Good visual design is about communication. A
well-designed application will make it easy for the user to understand the information that is being presented, and
show them clearly how they can interact with that information. If you can achieve all that, your application will look
good to the user, even if it doesn't have any fancy graphics or spinning logos!

1. Color
Color is a good tool for communicating information in a user interface. For example, it can be used to:

• strengthen a desktop's look and feel by enhancing a theme

• accent a dynamic alert in a system management application

• emphasize an element in a long list to expedite scanning

• add aesthetically pleasing details to an icon

However, color should always be regarded as a useful addition to your design, not as a necessity. Never depend
upon colors alone to display important information, and keep in mind that if colors cannot be perceived correctly
(for example, the user has an 8-bit system, or is colorblind), your application should still be usable.

1.1. Palette

A 32-color palette has been developed for the GNOME desktop. The palette may be downloaded from
http://www.ximian.com/images/art-devel/ximian-palette. To use it in The GIMP, save it to your
~/.gimp_1.2/palettes folder, and restart The GIMP. A single, consistently-used palette helps give a unified
look and feel to the desktop while minimizing visual distractions. If you need a color that is darker or lighter than
the colors in this basic palette (e.g., for antialiasing), choose a color that is closest to the hue you need, then darken
or lighten as required.

Figure 8.1. The basic GNOME 32-color palette

Table 8.1. RGB and hexadecimal values for the basic palette

Color Description RGB Hex Color Description RGB Hex

Basic 3D
Hilight

234 232 227 #EAE8E3 Basic 3D
Medium

186 181 171 #BAB5AB

Basic 3D
Dark

128 125 116 #807D74 3D Shadow 86 82 72 #565248

Green Hi-
light

197 210 200 #C5D2C8 Green
Medium

131 166 127 #83A67F

Green Dark 93 117 85 #5D7555 Green
Shadow

68 86 50 #445632
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Color Description RGB Hex Color Description RGB Hex

Red Hilight 224 182 175 #E0B6AF Red
Medium

193 102 90 #C1665A

Red Dark 136 70 49 #884631 Red
Shadow

102 56 34 #663822

Purple Hi-
light

173 167 200 #ADA7C8 Purple
Medium

136 127 163 #887FA3

Purple Dark 98 91 129 #625B81 Purple
Shadow

73 64 102 #494066

Blue Hilight 157 184 210 #9DB8D2 Blue
Medium

117 144 174 #7590AE

Blue Dark 75 105 131 #4B6983 Blue
Shadow

49 78 108 #314E6C

Face Skin
Hilight

239 224 205 #EFE0CD Face Skin
Medium

224 195 158 #E0C39E

Face Skin
Dark

179 145 105 #B39169 Face Skin
Shadow

130 102 71 #826647

Accent Red 223 66 30 #DF421E Accent Red
Dark

153 0 0 #990000

Accent Yel-
low

238 214 128 #EED680 Accent Yel-
low Dark

209 148 12 #D1940C

Accent
Green

70 160 70 #46A046 Accent
Green Dark

38 199 38 #267726

White 255 255 255 #ffffff Black 0 0 0 #000000

1.2. Hue, Brightness, Contrast

Users with vision disorders, such as colorblindess or low vision, require alternatives to default settings. A good user
interface anticipates these needs by providing customizable preferences and support for accessible themes. Even bet-
ter is an application that is already configured with carefully-chosen color and contrast defaults.

An estimated 11% of the world population has some sort of colorblindness. Those affected typically have trouble
distinguishing between certain hues such as red and green (deuteranopia or protanopia), or blue and yellow
(tritanopia). Therefore it is necessary to allow the user to customize colors in any part of your application that con-
veys important information. This means that your application must effectively convey information using just the col-
ors from any theme that the user chooses.

A useful tool for reviewing information about colorblindess and checking legibility of images for colorblind users is
Vischeck [http://www.vischeck.com/], an online tool that simulates the way an image or a website might appear to a
user who has deuteranopia, protanopia, or tritanopia.

Figure 8.2. How the earth looks to a user with normal color vision (left), deuteranopia
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(middle), and tritanopia (right). (Images from http://www.vischeck.com).

Other users have more problems with contrast levels rather than hue on their screen. Some users require a high level
of contrast between background and foreground colors, such as black on white, white on black, or some other high-
contrast combination. Others can experience discomfort unless they use low-contrast settings, such as gray text on a
lighter gray background.

You can meet these needs by ensuring your application supports the accessible GNOME themes (found in the
gnome-themes module in cvs), which include high and low contrast themes, and large print themes. This means you
must supply default and large sizes of high-, low- and regular-contrast icon sets with your application.

Guidelines

• Use the GNOME color palette. If you need a darker or lighter shade, start from one of the colors from the palette
and darken or lighten as needed.

• Do not use color as the only means to distinguish items of information. All such information should be provided
by at least one other method, such as shape, position or textual description.

• Ensure your application is not dependent on a particular theme. Test it with different themes, especially high and
low contrast accessibility themes, which use fewer colors, to ensure your application respects the settings. For
example, all text should appear in the foreground color against the background color specified in the chosen
theme.

• Select colors carefully. When they need to be recognizably different, select the light colors from orange, yellow,
green or blue-green, and darker colors from blue, violet, purple or red, as most people affected by colorblindness
already see blue, violet, purple and red as darker than normal.

2. Window Layout

2.1. General

Placement of visual components in an application is important because relationships between elements are indicated
by their positions. This is called "layout" in interface design.
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A clean layout is crucial to creating a smooth visual flow of information for the user. This section describes the
proper component placement and spacing to use in GNOME applications. The major components discussed will be
labels, icons, radio buttons and checkboxes, text fields, command buttons, and drop-down menus.

2.2. Dialogs

When a user is scanning a complex preferences dialog consisting of many labels and corresponding checkboxes, text
fields, and combo boxes, it is easy to see how she can quickly become hindered by poor layout in the visual design.
For information on laying out Alerts, see Section 4.3

Figure 8.3. Improved window layout

In Figure 8.3, the dialog on the left presents labels which are not left-aligned. The user's eye is not given a proper
anchor to scan the dialog quickly.

As the labels are all similar in length, they should be left-aligned. Now the user has a firm left margin to anchor the
eye and scan the list of items vertically more easily. If most of the labels in a group greatly differ in length, right-
align them instead, so that the controls do not end up too far away from their corresponding labels.

Using frames with visible borders to separate groups within a window is deprecated. Use spacing and bold headers
instead. This is more effective because there are fewer gratuitous lines to distract the user from the main content in
the window. See Section 18 for more details.

Try to keep components consonant with each other in terms of size and alignment. This is particularly important
within a group of controls, so that the user's ability to quickly scan information is not sacrificed. Minimize as much
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as possible the need for the user's eye to jump around when scanning a layout.

Figure 8.4. Layout specifications

Guidelines

• Leave a 12-pixel border between the edge of the window and the nearest controls.

• Leave a 12-pixel horizontal gap between a control and its label. (The gap may be bigger for other controls in the
same group, due to differences in the lengths of the labels.)

• Labels must be concise and make sense when taken out of context. Otherwise, users relying on screenreaders or
similar assistive technologies will not always be able to immediately understand the relationship between a con-
trol and those surrounding it.
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• Assign access keys to all editable controls. Ensure that labels immediately precede their associated control in the
tab order, so that the access key will focus to or activate the correct control when pressed.

2.3. Spacing and Alignment

Provide adequate space between controls and groups of controls. This white space will make it easier for the user to
find the information they need.

Guidelines

• As a basic rule of thumb, leave space between user interface components in increments of 6 pixels, going up as
the relationship between related elements becomes more distant. For example, between icon labels and associ-
ated graphics within an icon, 6 pixels are adequate. Between labels and associated components, leave 12 hori-
zontal pixels. For vertical spacing between groups of components, 18 pixels is adequate. A general padding of
12 pixels is recommended between the contents of a dialog window and the window borders.

• Break long lists of choices into smaller groups. For lists of less than about eight items, use radio buttons or check
boxes. For longer lists, use a list control or option menu.

• Try to keep elements of the same type left-aligned with each other. For instance, in Figure 8.4, the group titles
(General and Actions) are left-aligned and justified with each other.

• Indent group members 12 pixels to denote hierarchy and association.

• Minimize the number of alignment points in your window. An alignment point is an imaginary vertical or hori-
zontal line through your window that touches the edge of one or more labels or controls in the window.

• Right-justification within groups or the overall window (as indicated by the line labelled "justification" in Figure
8.4 is pleasing to the eye, but not crucial.

• Lay out components left-to-right, top-to-bottom. Generally, the first element the user is meant to encounter
should be in the top-left, and the last in the bottom right. Keep in mind that when localized for non-western lo-
cales, interfaces may be reversed so that they read from right to left.

• Using "white" or blank spacing and indentation to delineate groups is cleaner and preferable to using graphical
separators such as frames.

• Align controls in your layout EXACTLY. The eye is very sensitive to aligned and unaligned objects. If nothing
lines up with anything else in a window, it will be very hard for the user to scan the contents and find the infor-
mation he wants. Two things that almost line up, but not quite, are equally distracting.

• Be consistent. Use the same spacing, alignment, and component sizes in all dialogs appearing in your applica-
tion. The OK and Cancel buttons, for example, should all appear exactly 12 vertical and horizontal pixels from
the lower right corner of every dialog window.

• Ensure that light and dark areas as well as spacing are equally distributed around the window. Keep in mind that
every control or group of controls in your window has a visual "weight," depending on its overall size, color, and
how much white space it includes. Darker, larger areas are "heavier," while paler, smaller areas are "lighter."

• Do not design windows that are more than 50% longer in one dimension than in the other. People are more com-
fortable looking at windows and dialogs whose dimensions stay within the golden ratio (about 1.6 to 1), a ratio
that artists and architects have used to create aesthetically-pleasing buildings and paintings for thousands of
years.
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3. Text Labels
To a user with normal vision, textual output provides the majority of the information and feedback in most applica-
tions. To a visually-impaired user who may not be able to see or understand any additional graphical output, clear
textual output is critical. You must therefore choose and position text carefully on the screen, and leave the choice of
fonts and sizes to the user, to ensure that all users are able to use your application effectively.

3.1. Spacing and Alignment

Use spacing and alignment of text uniformly throughout your application. A basic rule of thumb is to put space be-
tween user interface components in increments of 6 pixels, going up as the relationship between related elements be-
comes more distant.

Table 8.2. Alignment and spacing for different Text elements

Element Placement Example

Large Icons (file browser) Horizontally centered with and (6
pixels, if specification neces-
sary)below large icon

Small icons (toolbar) Vertically centered with and (6 pix-
els, if specification necessary) to the
right of small icons

List control label 6 pixels above and horizontally left
aligned with list control or 12 pixels
to the left of and horizontally top
aligned with list control

Radio button and checkbox labels 6 pixels to the right of and vertically
center aligned with radio button

Textfield labels 6 pixels to the left of and vertically
center aligned with textfield control

Button labels 12 pixels of padding to either side of
centered text (and any accompanying
graphic). If appearing in a group of
buttons, longest button label sets but-
ton size, center all other button labels
and accompanying graphics in same-
sized buttons

Other component labels (e.g., spin
boxes, text fields

12 pixels between the longest text la-
bel and its associated component, all
other text labels in component group-
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Element Placement Example

ing left aligned with the longest label.
All labels vertically center aligned
with associated components

Guidelines

• If the label precedes the control it is labelling, end the label with a colon. For example, Email: to label a text
field into which the user should type their email address. This helps identify it as a control's label rather than an
independent item of text. Some assistive technology screen review utilities may also use the presence of a colon
to identify text as a control label.

• When you use static text to label a control, ensure that the label immediately precedes that control in the Tab or-
der. This will ensure that the access key (underlined character) you assign to the label will move focus to or acti-
vate the correct control when pressed.

• Left-align components and labels, unless all the labels in a group have very different lengths. If they do, right-
align the labels instead, to ensure that no controls end up too far away from their corresponding labels.

• Choose label names carefully. Label objects with names that make sense when taken out of context. Users rely-
ing on screenreaders or similar assistive technologies will not always be able to immediately understand the rela-
tionship between a control and those surrounding it.

• Be consistent with label usage and semantics. For example, if you use the same label in different windows, it
will help if it means the same thing in both windows. Equally, don't use labels that are spelled differently but
sound the same, e.g., "Read" and "Red", as this could be confusing for users relying on screenreaders.

• Don't use the same label more than once in the same window. This makes life difficult for users relying on tools
like magnifiers or screen readers, which cannot always convey surrounding context to the user.

• Do not hard-code font styles and sizes. The user should be able to adjust all sizes and typefaces.

• Do not use more than two or three different fonts and sizes in your application, and choose visually distinct
rather than similar-looking fonts in one window. Too many font sizes and styles will make the interface look
cluttered and unprofessional, and be harder to read. In general, always use fonts from the current theme, and
specify relative rather than absolute sizes.

• Do not use graphical backdrops or "watermarks" behind text, other than those specified by the user's chosen
theme. These interfere with the contrast between the text and its background. This can cause difficulty for users
with visual impairments, who will therefore normally choose themes that always use plain backdrops.

3.2. Capitalization

Two styles of capitalization are used in GNOME user interface elements:

Header capitalization Capitalize all words in the element, with the following excep-
tions:

• Articles: a, an, the.

• Conjunctions: and, but, for, not, so, yet ...

• Prepositions of three or fewer letters: at, for, by, in, to ...
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Sentence capitalization Capitalize the first letter of the first word, and any other words
normally capitalized in sentences, such as application names.

The following table indicates the capitalization style to use for each type of user interface element.

Table 8.3. Capitalization Style Guidelines for User Interface Elements

Element Style

Check box labels Sentence

Command button labels Header

Column heading labels Header

Desktop background object labels Header

Dialog messages Sentence

Drop-down combo box labels Sentence

Drop-down list box labels Sentence

Field labels Sentence

Filenames Sentence

Graphic equivalent text: for example, Alt text on web pages Sentence

Group box or frame labels Header

Items in drop-down combo boxes, drop-down list boxes, and list
boxes

Sentence

List box labels Sentence

Menu items Header

Menu items in applications Header

Menu titles in applications Header

Radio button labels Sentence

Slider labels Sentence

Spin box labels Sentence

Tabbed section titles Header

Text box labels Sentence

Titlebar labels Header

Toolbar button labels Header

Tooltips Sentence

Webpage titles and navigational elements Header

4. Fonts
Only use the fonts that the user has specified in their theme, and in sizes relative to the default size specified in their
theme. This will ensure maximum legibility and accessibility for all users.

Do not mix more than two or three font sizes and styles (underlined, bold, italicized) in one window, as this will
look unprofessional and distract the user from the information being conveyed.

Provide alternatives to WYSIWYG where applicable. Some users may need to print text in a small font but edit in a
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larger screen font, for example. Possible alternatives include displaying all text in the same font and size (both of
which are chosen by the user); a "wrap-to-window" option that allows you to read all the text in a window without
scrolling horizontally; a single column view that shows the window's contents in a single column even if they will
be printed in multiple columns; and a text-only view, where graphics are shown as placeholders or text descriptions.
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Chapter 9. Icons
Icons are a graphical metaphor presenting a visual image that the user associates with a particular object, state or op-
eration. When a user sees a good icon they are immediately reminded of the item it represents, whether that be an
application in the panel menu or the "right aligned" state in a word processor toolbar.

• Icons can assist the user in rapidly scanning a large number of objects to select the desired item. Particularly af-
ter a user is acustomed to an icon's appearance, they can identify it more rapidly than a text label.

• Icons can augment text by providing visual suggestions to accompany the descriptive text. Some things are eas-
ier to communicate with a picture, even a very small one.

• Icons can compactly represent a large number of objects when there is insufficient space to display textual de-
scriptions (such as in a toolbar).

1. Style
GNOME uses a soft, three-dimensional look. This style is achieved by using antialiasing, shading and highlighting
techniques. The Gnome Icons [http://www.ximian.com/devzone/tutorials/icon-design/] tutorial details how one of
GNOME's leading artists creates some of these effects.

Components of an icon style can be broken down into several categories such as perspective, dimentionality, light-
ing effects and palette. These components play an important part in giving a group of icons a collectively distinctive
look. For instance, the Java Look and Feel is recognizable by its use of a primary eight-color palette, interior high-
lighting and diagonal gradients. The Macintosh Aqua style is recognizable by its use of a cool palette based on blue,
lighting effects mimicking reflectivity and antialiasing. The GNOME style exhibits a subdued thirty-two color
palette, soft drop shadows and a mix between cartoonish and photorealistic graphics.

Table 9.1. A globe in different icon styles

Java Metal MacOS/X Aqua GNOME

1.1. Perspective

Table perspective. Presents objects as if they were sitting on a table or desk in front of the user.

Figure 9.1. Illustration of the table perspective
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Shelf perspective. Presents objects as if they were propped up on a shelf at eye level. Make it look like a police
line-up.

Figure 9.2. Illustration of the shelf perspective

1.2. Lighting

Upper left. Design as if there is lighting coming from the upper left corner, with a soft drop-shadow cast within the
icon's 48x48 (original design size) borders (120 degrees, 4 pixel distance, 4 pixel blur).

Overhead. Design as if there is a light source placed above the "camera", casting a shadow down.

1.3. Palette

Icons should use colors based on the basic thirty-two color palette, darkening or lightening the colours to achieve the
desired look. See Section 1.1

2. Kinds of Icons

Table 9.2. Specifications for different kinds of icons used within GNOME

Icon Type Sizes (pixels) Perspective Light Source

Object / Document Icons 24x24, 48x48*, 96x96 Table Upper Left

Application Icons 24x24, 48x48* Table Upper Left

Toolbar Icons 24x24*, 48x48 Shelf Overhead

Menu Icons 16x16 Shelf Overhead

(* denotes the primary size for this kind of icon)

2.1. Document Icons

If possible, document icons should convey the type of the file using a physical object. For example a good icon for
MPEG video would be a movie reel. Failing the existence of an appropriate object, when a document type corre-
sponds to a specific application, another option is to use a piece of paper with the corresponding application's icon
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overlayed it as the document icon. This may be appropriate for a document type such as an application's settings
files.

• Do not display a piece of paper behind a document icon unless the document type has a use correspondence with
physical paper (or a suitable object was not found and you are using the application icon). For example, the final
state of most word processing documents is a piece of paper, so it is appropriate to use a piece of paper in the
icon. On the other hand, a movie on the computer has little association with a piece of paper, so a piece of paper
behind the movie reel primarily introduces visual noise. The use of a piece of paper in most or all document
types creates an additional problem: it is harder to scan large numbers of icons because they do not possess dis-
tinct outlines. A useful technique for creating a subtle difference between document types with similar roles (for
example, between "JPEG", "PNG", "GIF", etc) is to use different colours. Expert users who need to make this
distinction frequently will become accustomed to these differences.

• Do not include a file extension in the icon. The document icon's job is not to convey such precise information
but to allow for rapid visual distinction between documents. Additionally, this text will not be displayed in the
user's preferred font and size. Because many document types are associated with multiple file extensions, a file
extension embedded in the icon will also frequently be wrong. In a context where the file extension is actually
useful, the application should composite the information onto the icon at runtime (thereby using the correct font
and size, as well as getting the extension right).

• Do not customize document icons to a particular Nautilus theme. Document icons are likely to be used in con-
junction with a variety of different icon themes, and should work well with all of them.

2.2. Application Icons

Application's that handle documents should reflect the kind of document they handle in the icon. If an application's
predominant purpose is to edit a particular kind of document, it should use this document's icon as its icon.

2.3. Toolbar Icons

The idea of a toolbar as a shelf filled with tools should be reflected in toolbar icons. Toolbar icons should have the
perspective of being viewed head on, as if they were actually sitting on a shelf at eye-level. Some design guides re-
fer to this perspective as "flush".

• Ensure that toolbar icons which will be used together are easy to visually distinguish. Try to make the icons' sil-
houettes distinct from one another.

• While most user's will view toolbar icons at 24x24 pixels, it is important to include a "large print" set of icons at
48x48 pixels for accesibility reasons.

• Often, you will not have to design any toolbar icons yourself as GTK provides a wide variety of stock icons.
You should use these whenever representing one of their intended items. This establishes consistent language
across applications, and makes it easier for users to search for items on the toolbar. Do not use stock toolbar
icons for anything other than their intended purpose, however, as this will make your application inconsistent
with others, and could easily confuse your users.

To browse the available stock icons, install the development packages for GTK version 2.x and run gtk-demo.
Double click on Stock Item and Icon Browser to activate the stock icon browser. Note that icons vary in avail-
able resolution, so the images presented in the icon browser should not be taken as indicative of the maximuum
quality of an image. To view the images in PNG format, look in the GTK 2 source code under gtk/
stock-icons.
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2.4. Menu Icons

Principles of toolbar icon design should be followed with menu icons, just at a smaller size. Where a corresponding
toolbar icon exists, a menu icon should mirror its design.

3. Designing Effective Icons

• Design Functionally Suggestive Icons. Icons should be suggestive of the functionality with which they are as-
sociated. The best icon will suggest to the user the primary purpose of the program or operation without having
to read accompanying text. Users recognize functionally suggestive icons more rapidly than other forms because
they directly associate with a physical object or action.

Figure 9.3. A functionally suggestive icon for a word processor

Figure 9.4. A functionally suggestive icon for underline

• Make Icon Silhouettes Distinct. It is important to make it easy to visually distinguish icons that will be used to-
gether, for example toolbar icons and document icons. The human visual system is excellent at making rapid dis-
tinctions between items based on shape, thus a good way to help your users sort through a large number of icons
is to use different shapes. You can see the shape of an icon most clearly by turning it into a silhouette: blacken
all areas of the icon which are not transparent.

Example 9.1. Distinct silhouettes from the Nautilus Crux theme

3.1. Suggested Design Process For Toolbar and Menu Icons

For accessibility reasons, you should create high and low contrast and large print versions of all icons, in addition to
the regular size and contrast icon. A suggested process for conveniently integrating this into your icon design is as
follows:
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1. Draw the basic outline as close to 48x48 pixels as possible:

2. Fill in with black and white to create detail. Do not add gratuities such as drop shadows or anti-aliasing:

3. Use the finished image as the large print high contrast icon:

4. GNOME will automatically scale it down to create the 24x24 high contrast icon:

5. Or you may hand-create a 24x24 version, which will be superior in contrast and sharpness:

6. Add color and anti-aliasing to the large print high contrast icon:

7. Add gradients for a smooth, realistic effect:

8. Add a drop shadow (120 degree global angle, 4 pixel distance, 4 pixel blur, 40% opacity), and use the finished
image as the large print regular contrast icon:

9. Now you should hand-create create a version of this icon at 24x24. Do not simply scale the larger icon, as this
icon will be seen by the majority of users and the result of scaling would be less distinct:

10. Create a layer with the large print regular contrast icon's same outline and size then overlay that on the color
icon. Give the overlay layer 40% opacity, and use the finished image as the large print low contrast icon:
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11. GNOME will automatically scale it down to create the 24x24 low contrast icon:

12. Or you may hand-create a 24x24 version, which will be superior in contrast and sharpness:

3.2. Problems to Avoid

• Avoid name suggestive icons. Some icons, such as the Nautilus icon, do not suggest the program's purpose, but
instead suggest the program's name. This is less desirable than a functionally suggestive icon, because an extra
layer of abstraction is added (rather than associating file management with an icon representing files, they have
to associate file management with nautilus with an image of a nautilus shell). Additionally it makes it difficult
for new users who may not know what "Nautilus" is, and hence will not recognize a shell icon as the file man-
ager.

Figure 9.5. A name suggestive icon for Nautilus

• Do not include meaningful text in icons. Icons which contain the text of the program name in the icon. They
effectively contain no metaphor or picture for the user to identify with, and are probably harder to read than the
accompanying caption. Since icons draw the eyes, an icon that is harder to identify than text is potentially worse
than no icon at all. Hence "text icons" should not be used. Moreover, text should be avoided in icons because it
makes the icons difficult to translate. If there is text in icons it should not form words in your native language, a
good metric for ensuring that the particular text is not lending to the meaning of the icon.

Figure 9.6. Text in the old GEdit icon

• Do not rely on information your users will not have. Random icons appear to have no association with the
program (except perhaps some odd connection in the mind of the developer). These icons should never be used
and will likely serve to confuse the user more than help them. The icon's purpose should not be to "look pretty";
this is merely a very desirable side effect. The sodipodi logo is a squirrel, which they show as their icon. How-
ever, because the logo has no obvious connection to a user, it is a poor icon. Make sure that you are not relying
on information that users won't necessarily posses.
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Figure 9.7. A seemingly random icon for SodiPodi

• Do not include extraneous information. Remember that icons will often be viewed in a smaller form. Too
much information may render the icon unintelligable when it is shrunk in size (e.g. to be placed on a panel, or in
the tasklist). Too much information also makes it easier for users confuse the purpose of the application. For ex-
ample, in user testing many users thought the Evolution icon would launch a word processor. They were misled
by the pencil and the paper, which could be seen as extraneous information: it is implicit that the mail program
will allow you to write messages as well as receive them. A better icon might have been a simple envelope.
Foremost in the icon designer's mind should be a consideration of the minimal visual elements necessary to ex-
press the purpose of the program.

Figure 9.8. Extraneous information - the Evolution icon

The Gnumeric icon is a great icon except for the introduction of extra visual noise. The extra sheet of paper with
the 'g' on it behind the spreadsheet and chart adds no significant value to the icon and provides extra visual dis-
traction. In this case the contribution of the extraneous element to the appearance of the icon is negative. Simple
well balanced icons look more attractive than cluttered icons. An improved icon might contain only the spread-
sheet and chart; larger because they can use all of the space in the icon, and hence more visually distinct.

Figure 9.9. Extraneous information - the old Gnumeric icon

• Do not include body parts in the icon. Because GNOME aims to be an international desktop, it needs to avoid
imagery that is potentially offensive or crass to other cultures. A prime source of offensive imagery is various
body parts in a number of different configurations. Aside from offensive gestures with the hands, arms or fin-
gers; body parts that are considered "clean" in one culture (such as eyes), will be considered tasteless or gross to
another (such as a nose). Based on a survey of icons in GNOME, body parts frequently appear in the least com-
municative icons (often "pointing" at some element in the icon); they are being used as an ineffective crutch for
poor metaphor. In these situations body parts should not be used. Even in situations where the metaphor is ap-
propriate (for example an eye representing the sawfish appearance capplet) it is better to avoid using a body part.
Often body parts have been used in GNOME to suggest a human "choosing" or "using" something. This is nor-
mally an unnecessary point for the icon designer to make. People naturally attempt to understand objects in ref-
erence to themselves (show someone a bat and they will think of hitting something with the bat, show someone a
tool and they will think of using it, etc). For example, the font selector shows a finger pointing to an "F" suggest-
ing the user choosing between a series of fonts. A better icon would be the text "Aa" presented in an ornate font
(calling attention to the font rather than the text). The user doesn't need to be told that they are "choosing" the
font, they can infer that easily.
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Figure 9.10. Using body parts - the font selector icon

Figure 9.11. A better icon for the Font Selector

• Do not base icons off word puns. This should be avoided for a couple reasons, the most obvious of which is
that puns do not translate well. For example, representing the "system log monitor" as a log will likely be un-
communicative in languages other than English. Additionally, most users do not comprehend the word play until
it is too late for the icon to assist them. Even after being familiar with the "system log monitor" being repre-
sented as a log, users do not form the association fast enough for the icon to assist through in scanning through
menu entries. A popular instance of this problem was the proliferation of icons representing the "World Wide
Web" as a spider web in the mid 1990s. Part of the value of icons is that they bypass linguistic comprehension
and hence are complementary to captions, allowing users to utilize more areas of the mind than linguistic recog-
nition (already used in scanning for captions) when they hunt for items.

Figure 9.12. Word play - System Log Monitor icon

• Do not employ violent imagery. Just as words like "kill" and "slay" are inappropriate in interfaces, violent or
destructive icons should be avoided. The "shut down" icon uses the image of an explosive detonation switch,
presumably trying to convey the idea of ending something abruptly. However, this icon is likely to intimidate
some users of the computer who will not want to click on the icon for fear of breaking something.

Figure 9.13. Destructive-looking Shutdown icon
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Chapter 10. User Input

1. Mouse Interaction

1.1. Buttons

Figure 10.1. A plethora of pointing devices: mouse, trackball, foot-operated mouse,
joystick, trackpad, and a finger-mounted pointing device.

For most users, the mouse provides the main way of interacting with graphical user interfaces. The term "mouse" is
used here to include other pointing devices that can be used to move the pointer around the screen, such as track-
balls, trackpads, spaceballs, graphics tablets, or assistive technology devices that emulate a mouse.

For right-handed users, the left button on a conventional mouse is used for the majority of mouse actions. We there-
fore call it the left button here, even though it may not always physically be so. For this reason, you may sometimes
see this referred to in code or documentation as "Button 1" or the "Selection Button".

Also for right-handed users, the right button on a conventional mouse is the one used for operations involving pop-
up menus. We therefore call it the right button here, even though it may not always physically be so. You may
sometimes see this referred to in code or documentation as "Button 3" or the "Menu Button".

A conventional mouse with three buttons normally has its third button (or a scrollwheel that acts as a button when
pushed) between the left and right buttons. We therefore call it the middle button, but you may sometimes see this
referred to in code or documentation as "Button 2" or the "Transfer Button".

Guidelines

• Your application uses left button gestures for selecting, activating components, dragging, and the display of
drop-down menus.

• Your application uses right button gestures to display and select actions from a popup menu.

• Your application uses the middle button to paste the current PRIMARY (usually the last-highlighted) selection
at the pointer position, as follows:

Table 10.1. Effect of modifier keys on a middle button transfer operation

Modifier Function

Unmodified Copy selection

Ctrl Copy selection

Shift Move selection
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Modifier Function

Shift-Ctrl Create link, shortcut or alias to selection

Do not over-ride this functionality in any part of your user interface where the transfer action is likely to be use-
ful. If you do intend to use the middle button for a different purpose somewhere, only do so as a shortcut for ex-
perienced users, and only for operations that can also be performed without using the right button or middle but-
ton.

• If present, the scrollwheel should scroll the currently focused window or control, if it supports scrolling.

• Do not depend on input from the middle or right mouse buttons. As well as being physically more difficult to
click, some pointing devices and many assistive technology devices only support or emulate the left mouse but-
ton. Some assistive technologies may noteven emulate the mouse at all, but generate keyboard events instead.

• Ensure that every operation in your application that can be done with the mouse can also be done with the key-
board. The only exceptions to this are actions where fine motor control is an essential part of the task. For exam-
ple, controlling movement in some types of action games, or freehand painting in an image-editing application.

• Do not warp the mouse pointer, or restrict mouse movement to part of the screen. This can interfere with assis-
tive technologies, and is usually confusing even for users who do not rely on assistive technologies.

• Do not require the use of chording (pressing multiple mouse buttons simultaneously) for any operations.

• Do not require the use of multiple (triple- or quadruple-) clicking actions for any operations, unless you also pro-
vide an accessible alternative method of performing the same action.

• Allow all mouse operations to be cancelled before their completion. Pressing the Esc key should cancel any
mouse operation in progress, such as dragging and dropping a file in a file manager, or drawing a shape in a
drawing application.

• Do not assign any actions exclusively to the middle button of a three-button mouse, as not all mice have one.

• Do not hard-code mouse target sizes, or make them too small. Define any mouse targets to be at least as large as
the arrow button in a GtkSpinBox in the current gtk theme. Bear in mind that a user with impaired dexterity or
vision may be using a theme that results in considerably larger widgets than the default theme.

• Do not refer to particular mouse buttons in your interface unless absolutely necessary. Not everybody will be us-
ing a conventional mouse with left, middle and right buttons, so any text or diagrams that refer to those may be
confusing.

1.2. Selecting Objects

1.2.1. Mouse and keyboard equivalents

For controls or windows that contain a number of objects that the user can select, either singly or multiply, ensure
the following mechanisms are in place to allow selections to be made using either the mouse or the keyboard.

Table 10.2. Standard mouse and keyboard selection mechanisms

Mouse Keyboard

Select item, deselect all others Click Space

Add/remove item from selection Ctrl click (toggles item's selected
state)

Ctrl-Space (toggles focused item's
selected state)
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Mouse Keyboard

Extend selection Shift click Shift-Space, Ctrl-Home, Shift-End,
Shift-PageUp, or Shift-PageDown

Move focus Click appropriate item to select it Cursor keys, Home, End, PageUp,
and PageDown move focus and se-
lection simultaneously.

Ctrl-cursor keys,
Ctrl-Home,Ctrl-End, Ctrl-PageUp,
and Ctrl-PageDown move focus
without affecting current selection.

Select All Click first item, then Shift click last
item

Ctrl-A

Deselect All Click container background Shift-Ctrl-A

Activate selection Double-click to activate a single se-
lection. Shift or Ctrl double-clicking
extends or adds item to selection first
before activating the entire selection.

Return activates entire selection. If
nothing is currently selected, selects
currently-focused item first.

Invert Selection No mouse equivalent Ctrl-I

1.2.2. Bounding Box Selection

For a container whose objects may be arranged in two dimensions (e.g. Nautilus "View as Icons"), allow multiple
selection by dragging a bounding box around one or more objects. Shift left button drag should add all the objects
within the bounding box to the existing selection. Ctrl left button drag should toggle the selected state of all the ob-
jects within the bounding box.

Guidelines

• By default, select only objects that are completely enclosed by the bounding box when the mouse button is re-
leased.

• Use dynamic highlighting to show which objects are currently selected while the box is being dragged out. Do
not wait until the mouse button is released. This avoids any uncertainty about which objects will be selected by
the bounding box.

• When a bounding box is being dragged out within a scrollable window, support automatic scrolling of that win-
dow when the box is dragged near the window's edges.

Figure 10.2. Examples illustrating dynamic selection highlighting during bounding box
selection. In the first example, the folder color and label highlighting changes to indicate
selection. In the second, selection is indicated by the addition of resizing handles to selected
objects.

Chapter 10. User Input

113



1.3. Drag and Drop

Drag and drop is a direct manipulation technique, by which you perform actions on selected objects by moving them
around the screen with the mouse. An object is dragged by clicking it with the left mouse button, then moving the
pointer to the object's target location while the button is still pressed. The object is dropped there by releasing the
mouse button.

Guidelines

• Provide visual feedback throughout a drag and drop operation. Highlight valid targets and change the mouse
pointer as it passes over them. Use the "no drop" mouse pointer when passing over invalid drop targets.

• Augment the mouse pointer with a representation of the objects being dragged. Keep this representation small or
make it translucent, so as not to obscure possible drop targets underneath it.

Figure 10.3. Example of copy pointer augmented by an icon representing the file being
copied

• Allow the user to undo the effects a drag and drop operation by selecting Edit->Undo.
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• Only allow objects to be copied between applications, not moved. This avoids any confusion about which appli-
cation's Undo function reverses the operation.

• A drag and drop operation can be cancelled by: pressing Esc before releasing the mouse button, by dropping the
object back on its original source, or by dropping the object on an invalid drop target.

• Allow multiple objects to be dragged by Shift or Ctrl selecting them, then dragging any one of the selected ob-
jects.

• Ensure that keyboard users can replicate all drag and drop actions using shortcut keys, such as Copy (Ctrl-C)
and Paste (Ctrl-V).

• Use standard pointer shapes across all GNOME applications for move, copy, multiple move, multiple copy, and
invalid drop target.

• When an item is being dragged within or into a scrollable window, support automatic scrolling of that window
when the mouse is moved near its edges.

• Pop up a menu when the user attemps to drop multiple objects on a target that only accepts single objects. On the
menu, list all the objects being dragged, and a Cancel item.

• Move selected objects when the user drags them within a container. Copy or link to selected objects when the
user drags them between containers. A "container" may be a boundary imposed by the user interface (e.g. a top-
level application window), or a user interface representation of a physical container (e.g. a mail server or disk
partition).

Allow the user to modify the default behavior of a drag and drop operation by holding the Ctrl and/or Shift key
throughout. If the user changes the modifier keys during the drag, e.g. to change a move operation to a copy, change
the mouse pointer immediately and perform the new action when the mouse button is released.

Table 10.3. Effect of modifier keys during a drag and drop operation

Modifier Function

Ctrl Copy

Shift Move

Shift-Ctrl Create link, shortcut or alias

1.3.1. Mouse Pointers to Use for Drag and Drop

Use the default GTK drag and drop pointers for the standard transfer operations listed below. This consistency helps
ensure the user will know exactly what to expect when they release the mouse button. If you do have to design a
new pointer for a non-standard transfer action not listed here, follow the style of the standard pointers.

Table 10.4. Mouse Pointers for Drag and Drop

Pointer Shape Meaning

Move selection. The dragged selection will be moved to
the drop location, removing it from its previous location.

Copy selection. The dragged selection will be copied to
the drop location, leaving the original intact.
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Pointer Shape Meaning

Link selection. A link to the selection will be inserted at
the drop location. How the link appears will be applica-
tion-dependent, it may be a hyperlink, an icon, or a du-
plicate of the orignal selection, for example.

Can't drop here. Show this pointer while the mouse is
over an area where the selection cannot be dropped.

1.4. Mouse Interaction with Panel Applications (Applets)

All objects on the desktop must behave consistently. Despite their specialized nature, applets are no exception.

Guidelines

• The unmodified left mouse button must be sufficient to operate all your applet's controls. Applets are meant to
be simple enough that modified clicking, or clicking with other mouse buttons (except to pop up the applet's
menu) is never required.

• Clicking the right button anywhere within the applet's enclosing window must display either the popup menu for
the whole applet, or the popup menu for the control under the mouse pointer. Do not have "dead areas" in your
applet that do not respond to a right click.

• Do not use the middle button for anything except dragging the applet to a new location. Middle-clicking and
dragging anywhere within the applet window must move the applet, do not require a drag bar or similar device.

Ctrlleft button drag should copy the applet, if moving to another panel; unmodified drag or Shiftleft button drag
should move the applet, if moving to another panel. If moving within same panel, Ctrl=switched movement,
Shift=push movement, Alt=free movement.

2. Keyboard Interaction

2.1. Keyboard Navigation

A well-designed keyboard user interface plays a key role when you are designing applications. Many power-users
prefer to perform most operations with the keyboard rather than the mouse. Visually-impaired users can navigate
software more effectively using the keyboard, because using the mouse depends on visual feedback of the mouse
pointer location. And mobility impairments can prevent a user from successfully navigating using the mouse, be-
cause of the fine motor control skills required.

Make all mouse actions available from the keyboard, and include keyboard access to all toolbars, menus, links and
buttons. Every function your application provides must be available using the keyboard alone. Hiding your mouse
while you test your application is a great way to test this!

Figure 10.4. Dialog box and menu, with some of their access and shortcut keys indicated
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Most functionality is easy to make available from the keyboard, by using access keys and shortcut keys, and the
toolkit's built-in keyboard navigation features. All controls with labels should have access keys, and frequently-used
menu items should be assigned shortcut keys. However, operations that rely on drag-and-drop, for example, may re-
quire more thought to make them keyboard accessible.

Guidelines

• Provide efficient keyboard access to all application features. In particular, ensure every control on menus and in
dialog boxes are directly focusable using access keys or shortcut keys.

• Use a logical keyboard navigation order. When navigating around a window with the Tab key, keyboard focus
should move between controls in a predictable order. In Western locales, this is normally left to right and top to
bottom.

• Ensure correct tab order for controls whose enabled state is dependent on checkbox, radio button or toggle but-
ton state. When such a button is selected, all its dependent controls should be enabled, and all the dependent con-
trols of any other button in the group should be disabled. When the user selects a checkbox, radio button or tog-
gle button that has dependent controls, do not automatically give focus to the first dependent control, but instead
leave the focus on the button.

• Do not over-ride existing system-level accessibility features. For example, the MouseKeys feature in the
GNOME Keyboard Accessibility preferences dialog allows mouse movement and button clicks to be simulated
using the keypad. Therefore you cannot add features to your application that can only be accessed by pressing
keys on the keypad, as users relying on the MouseKeys feature will not be able to use them.

• Ensure that any text that can be selected with the mouse can also be selected with the keyboard. This is a conve-
nience for all users, but especially for those for whom fine control of the mouse is difficult.

• Ensure that objects that can be resized or moved by drag and drop can also be resized or moved with the key-
board. For example, icons and windows on the desktop. Where precision sizing and placement is potentially im-
portant, e.g. shapes in a diagram, also consider providing a dialog into which you can type co-ordinates, or a
means of snapping objects to a user-definable grid.
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• Do not use general navigation functions to trigger operations. For example, do not use basic Tab keyboard navi-
gation in a dialog to activate any actions associated with a control.

• Show keyboard-invoked menus, windows and tooltips near the object they relate to, but without hiding or ob-
scuring the object to which the menu or tooltip refers,. In GNOME, popup menus are activated with Shift-F10,
and tooltips with Ctrl-F1.

• Provide more than one method to perform keyboard tasks where possible. Users may find some keys and key
combinations easier to use than others.

• Do not assign awkward reaches to frequently performed keyboard operations. Some people may only be able to
use one hand on the keyboard, so shortcuts that can be easily used with one hand are preferable for common op-
erations. In any case, having to frequently perform long or difficult reaches on the keyboard can increase muscle
strain for all users, increasing the risk of pain or injury.

• Do not require repetitive use of simultaneous keypresses. Some users are only able to press and hold one key at a
time. Assistive technologies such as the GNOME Keyboard Accessibility preferences dialog do allow users to
press the keys sequentially rather than simultaneously, but this of course means the operation will take longer for
them.

2.2. Choosing Access Keys

Give all labelled components an access key (underlined letter), with the exception of toolbar control which would
use up too many access key combinations.

Choose access keys to be as easy to remember as possible. Normally, this means using the first letter of the label.
However, in complex windows, the choice can become more difficult. Here are some simple rules:

1. Assign access keys to the most frequently-used controls first. If it's not clear which controls will be the most
frequently used, assign access keys from left to right, top to bottom (for Western locales).

2. Use the first letter of the label, or of one of its other words if it has more than one. If another letter provides a
better association (e.g. "x" in Extra Large) however, consider using that letter instead.

3. If the first letter is not available, choose an easy to remember consonant from the label, for example, "p" in Re-
place.

4. If no such consonants are available, choose any available vowel from the label.

Do not assign access keys to "thin" letters (such as lowercase i or l), or letters with descenders (such as lowercase g
or y) unless you have to. The underlines often do not show up very well on those characters.

Applications using a non-Roman writing system in conjunction with a standard keyboard can have control labels
prefixed with Roman characters as access keys.

2.3. Choosing Shortcut Keys

The tables in Section 2.4 summarize the standard shortcut keys to use when your application supports those func-
tions. Your application will not necessarily support all of these functions, see Section 4 for more information. How-
ever, use the recommended shortcut keys for those functions you do support.

You will probably want to add your own shortcut keys for functions specific to your application. If so, as well as fol-
lowing the guidelines below, look at any other existing similar applications to see which shortcut keys they have de-
fined. Your users may already be using those or similar applications, so being consistent where it is possible and
sensible to do so will provide a better user experience for them when they begin to use yours.

Chapter 10. User Input

118



Guidelines

• Use Ctrl-letter in preference to other combinations when choosing new shortcut keys.

• Insert, Delete, Home, End, Page Up and Page Down are acceptable shortcut keys for functions that are closely
related to those keys' normal system-defined uses. Do not assign them to unrelated functions just because you've
run out of other shortcut key combinations, however.

• Only assign shortcut keys to the most commonly-used actions in your application. Do not try to assign a shortcut
key to everything.

• Choose new shortcut keys to be as mnemonic as possible, as these will be easier to learn and remember. For ex-
ample, Ctrl-E would be a good shortcut for a menu item called Edit Page.

• Use Shift-Ctrl-letter for functions that reverse or extend another function. For example, Ctrl-Z and
Shift-Ctrl-Z for Undo and Redo. Note that you cannot use Shift-Ctrl-A-thru-F, however, as these combina-
tions are used to enter unicode characters in text fields.

• Do not use Ctrl-number or numbered function keys as shortcut keys, unless the number has some obvious rele-
vance to the action. For example, Ctrl-2 and Ctrl-3 may be acceptable shortcut keys for View->2D View and
View->3D View in a 3D modelling application.

• Do not use Alt-key combinations for shortcut keys, as these may conflict with window manager or menu access
keys.

• Do not use symbols that require Shift or other modifiers as part of a shortcut, for example Ctrl-%. Remember
that symbols that can be accessed without a modifier key on your keyboard may be more difficult to access on
different international keyboards.

• Do not assign shortcut keys to menu items that change over time, for example a list of open windows on the
Window menu, or a recently-used file list on the File menu. Do assign access keys to these items, however.

• Do not use any of the standard shortcut keys listed in Section 2.4 for your own purposes, even if your application
doesn't support those functions. This helps reinforce consistency between all GNOME applications.

2.4. Standard Application Shortcut Keys

If your application uses any of the standard functions listed in the following tables, use the recommended standard
keyboard shortcut for that function.

Table 10.5. Standard GNOME application shortcut keys and access keys - File menu

Function Shortcut Description

New Ctrl-N Create a new document

Open Ctrl-O Open a document

Save Ctrl-S Save the current document

Print Ctrl-P Print the current document

Send To... Ctrl-E Send the current document to an
email recipient or remote location

Close Ctrl-W Close the current document

Quit Ctrl-Q Quit the application
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Table 10.6. Standard GNOME application shortcut keys and access keys - Edit menu

Function Shortcut Description

Undo Ctrl-Z Undo the last operation

Redo Shift-Ctrl-Z Redo the last operation

Cut Ctrl-X Cut the selected area and store it in
the clipboard

Copy Ctrl-C Copy the selected area into the clip-
board

Paste Ctrl-V Paste contents of clipboard at mouse/
cursor position

Duplicate Ctrl-U Duplicate the currently-selected items
and add them to the same window,
without affecting the clipboard

Select All Ctrl-A Select everything in focused control
or window

Invert Selection Ctrl-I Select everything in focused control
or window that was previously unse-
lected, and deselect everything that
was previously selected

Delete Del Delete selection

Find Ctrl-F Find matches in the current docu-
ment, highlighting them in-place

Search Ctrl-F (see note below) Search for matches in multiple docu-
ments, files or other external sources

Find Next Ctrl-G Find the next match

Replace Ctrl-H Find and replace matches

Rename F2 Switch the selected item's label into
edit mode, allowing user to type in a
new name.

Table 10.7. Standard GNOME application shortcut keys and access keys - View menu

Function Shortcut Description

Zoom In Ctrl-Plus Zoom in on the document

Zoom Out Ctrl-Minus Zoom out of the document

Refresh Ctrl-R Redraw current view of document,
without checking if content has
changed

Reload Ctrl-R (see note below) Reload the current document, updat-
ing content from source if necessary

Table 10.8. Standard GNOME application shortcut keys and access keys - Bookmarks
menu
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Function Shortcut Description

Add Bookmark Ctrl-D Add a bookmark for the current loca-
tion

Edit Bookmarks... Ctrl-B (see note below) Open a window in which the user can
edit and organise saved bookmarks

Table 10.9. Standard GNOME application shortcut keys and access keys - Go menu

Function Shortcut Description

Back Alt-Left Go to the previous location in the
navigation chain

Next Alt-Right Go to the next location in the naviga-
tion chain

Up Alt-Up Go up one level in the navigation hi-
erarchy

Home Alt-Home Go to the starting page defined by the
user or application

Table 10.10. Standard GNOME application shortcut keys and access keys - Format menu

Function Shortcut Description

Bold Ctrl-B Make selected text bold/regular

Underline Ctrl-U Underline/remove underline from se-
lected text

Italic Ctrl-I Make selected text italic/regular

Table 10.11. Standard GNOME application shortcut keys and access keys - Help menu

Function Shortcut Description

Contents F1 Show help contents page for the cur-
rent application

2.4.1. Standard Window Manager Shortcut Keys

The following shortcut keys are used by many window managers, and should not normally be over-ridden by your
application.

Table 10.12. Standard window manager shortcut keys and access keys

Function Shortcut Description

Switch windows Alt-Tab, Shift-Alt-Tab Switch focus to the next or previous
window on the desktop

Switch panels Ctrl-Alt-Tab, Shift-Ctrl-Alt-Tab Switch focus to the next or previous
panel on the desktop
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Function Shortcut Description

Window menu Alt-Space Pop up window menu

Close Alt-F4 Close the focused window

Restore Alt-F5 Restore the focused to its previous
size

Move Alt-F7 Move the focused window

Resize Alt-F8 Resize the focused window

Minimize Alt-F9 Minimze the focused window

Maximize Alt-F10 Maximize the focused window

Full Screen Ctrl-F11 Show the window in full screen
mode, with no border, menubar, tool-
bar or statusbar

2.4.2. Standard Widget Navigation Shortcut Keys

The following shortcut keys are reserved for keyboard navigation use by the various widgets used in GNOME, and
should not normally be over-ridden by your application.

Table 10.13. Standard GNOME keyboard navigation keys for widgets

Key Function

Tab, Shift-Tab Moves keyboard focus to next/previous control

Ctrl-Tab, Shift-Ctrl-Tab Moves keyboard focus out of enclosing widget to next/
previous control, in those situations where Tab alone has
another function (e.g. GtkTextView)

Ctrl-F1 Pop up tooltip for currently-focused control

Shift-F1 Show context-sensitive help for currently-focused win-
dow or control

F6, Shift-F6 Give focus to next/previous pane in a GtkPaned window

F8 Give focus to splitter bar in paned window

F10 Give focus to window's menu bar

Shift-F10 Pop up contextual menu for currently-selected objects

Space Toggle selected state of focused checkbox, radio button,
or toggle button

Return Activate focused button, menu item etc.

Home, End Select/move to first item in selected widget

PageUp, Ctrl-PageUp, PageDown, Ctrl-PageDown Scroll selected view by one page up/right/down/left

2.4.3. Additional Widget Navigation Shortcut Keys

The following emacs-style navigation shortcut keys are still available in GNOME 2.0 text entry fields (by selecting
the "emacs" scheme in the GNOME Keyboard Shortcuts preferences dialog), but are disabled by default. Since
some users will still want to use them, do not over-ride them for your own purposes in any situations where a text
entry control has focus.
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Table 10.14. Emacs-style navigation keys for widgets

Key Function

Ctrl-A Move cursor to beginning of line

Ctrl-D Delete character following/under cursor

Ctrl-E Move cursor to end of line

Ctrl-K Delete from cursor to end of line

Ctrl-U Delete current line

Ctrl-W Cut to clipboard

Ctrl-Y Paste from clipboard

Ctrl-Space Set mark

Ctrl-Del, Alt-D Delete from cursor to end of word

Ctrl-Backspace Delete from cursor to start of word

Alt-Space Delete all whitespace around cursor, reinsert single space

Alt-\ Delete all whitespace around cursor

2.5. Keyboard Interaction with Panel Applications (Applets)

Panels have been fully keyboard navigable since GNOME 2.0. Since your panel application can gain keyboard fo-
cus, you must ensure that it is also keyboard navigable.

The rules for panel application keyboard navigation are mostly the same as those for any other window. However,
there is one imporant difference:

• Do not use the the Tab key as the means of moving focus between controls in a panel application. Use the arrow
keys for this purpose instead.

When an object on a panel has focus, the Tab key normally moves focus to the next object on the panel. If your
panel application also used Tab for its own internal navigation, the user would have to press Ctrl-Tab to move fo-
cus out of your panel application instead. This inconsistency would be detremental to the user experience.
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Chapter 11. Language
Consistent labelling creates a familiar environment that the user can navigate comfortably. The more familiar the en-
vironment, the easier task of finding information.

1. Labels

1.1. Controls

Clear, consistent and concise labelling of controls helps users to work out the purpose of a window or dialog they
have never seen before. To a visually-impaired user, clear labels are even more important. A user who relies on a
screenreader has no assistance from icons, layout, or spacing to work out what the controls do, so clear labelling is
essential.

Guidelines

• Keep labels short. This:

• Reduces the expansion of text when translated, and thus minimizes the effort required to localize the UI.
Translated English text can expand up to 30% in some languages.

• Facilitates the use of translation engines.

• Improves speed of comprehension for the user.

Do not shorten your labels to the point of losing meaning, however. A three-word label that provides clear infor-
mation is better than a one-word label that is ambiguous or vague. Try to find the fewest possible words to satis-
factorily convey the meaning of your label.

• Do not include text in windows that describes how to use the interface, for example You can install a new theme
by dropping it here. As well as adding visual clutter, descriptive labels can also conflict with information pro-
vided in documentation.

• Use standard terms. You can find a list of standard user interface terms in the GNOME Documentation Style
Guide, Recommended Terminology [http://developer.gnome.org/documents/style-guide/wordlist.html]..

• Apply standard capitalization rules. See Section 3.2 for guidelines about capitalization of user interface labels

1.2. Tooltips

1.2.1. Toolbar Tooltips

A toolbar tooltip is the short description of a toolbar control's functionality that the user sees when they mouse over
it.

Guidelines

• Concisely state the purpose of the control. The tooltip should be more descriptive than the corresponding menu
item name, if there is one, but not verbose. For example, Undo last action for the Undo button.
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• Use sentence capitalization rules. See Section 3.2.

1.2.2. Application Tooltips

An application tooltip is the short description of your application that the user sees when they mouse over the
launcher or menu item for your application. It is stored in the comment field of your application's desktop file.
See Section 1.2

Guidelines

• Create short tooltips. Aim to accurately communicate the functionality of an element with the fewest words pos-
sible.

• Use sentence capitalization rules. See Section 3.2.

• Use standard punctuation rules, with the exception that you do not use a period to end the tooltip.

1.3. Menus

Guidelines

• Use the recommended standard labels for menu items and titles, where they exist. Do not use synonyms such as
Exit instead of Quit. See Section 4 for a list and descriptions of standard menu items and titles.

• Use header capitalization rules for all menu items and titles. See Section 3.2 for more information.

2. Warning and Error Messages
A good warning or error message contains two elements:

1. A brief description of the problem.

2. A list of ways the user can remedy the problem.

Both of these elements should be presented in non-technical, jargon-free language, unless your target audience is
particularly technically-minded.

If your application knows enough about the problem to be able to give all this information to the user, it will often
be capable of rectifying the problem itself when the user has decided which course of action they want to take. For
example, if the problem is insufficient memory, tell the user which currently-running application is taking up the
most memory, and provide a button to close it for them. (Do not offer to launch a graphical process manager, how-
ever, which is something most users should never see!)

See Section 4 for more detailed information on writing and presenting errors, warnings and information alerts.

3. Online Help
Writing online help is a specialized task, and is therefore not covered in any depth here. Refer to the GNOME Docu-
mentation Styleguide [http://developer.gnome.org/documents/style-guide/index.html] for guidance on writing clear,
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consistent and helpful documentation for your application.
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Chapter 12. Checklists

1. Things You Can Do Yourself

1.1. Before You Start

Write down the type of people you expect to use your application. Then write some "scenarios" for each type of
user— a little story that describes the typical tasks those users will use your application for. These tasks should be
along the lines of:

Fred needs to find an email about widgets that he received last week

rather than

Fred clicks on the Find button and types widgets into the dialog.

This way, you can use the same scenarios to test and compare different interface designs, and to spot any missing
functionality.

Include these user descriptions and scenarios with the documentation you commit to CVS. This way, other contribu-
tors will get to understand your users too, can help to develop the application with that knowledge, and can provide
more scenarios of their own.

1.2. Keyboard Access and Focus

When you have started implementing your interface, hide your mouse, and make sure you can still use it to do ev-
erything using only the keyboard. Implement keyboard functionality at the same time as mouse functionality— don't
leave it until the end.

Using only keyboard commands, move the focus through all menu bars and toolbars in the application. Also confirm
that:

• Context sensitive menus display correctly (Shift-F10).

• Tooltips can be popped up and down for all controls that have them (Ctrl-F1, Esc).

• All functions listed on the toolbar can be performed using the keyboard.

• You can fully operate every control in the client area of the application and dialog boxes.

• Text and objects within the client area can be selected.

• Any keyboard enhancements or shortcut keys are working as designed.

• Verify that when moving among objects, the visual focus indicator is easy to identify at all times.

1.3. Theming, Colors and Contrast

Test various GNOME themes to ensure that your application respects all the available settings.

Test your application with black and white, high contrast themes and confirm that all information is still conveyed
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correctly. If you don't have a suitable high contrast GNOME theme available to test, print off some screenshots in
black and white (not greyscale) and make sure all the important information is still visible— this will approximate
what a high contrast theme user will see.

1.4. Animation

Ensure you have implemented an option to turn off any animation in your application (for accessibility reasons), and
that it is working as designed. Turn the animation off. Confirm that all information is still conveyed correctly.

2. Things You Can Do With Other People

2.1. Get Early Feedback

It's always tempting, but don't start coding your interface straight away. Sketch out some ideas on paper first, or in
Glade or HTML if you prefer. (But don't be tempted add any functionality at this point if you do it this way!)

Show these prototypes to other people— the GNOME mailing lists and IRC are ideal for finding likely candidates.
Ask them to use these prototype interfaces to run through some of the scenarios you came up with earlier. You'll
probably get questions like "how would I do X", "which menu is Y on"... these questions will help you think about
the interface from the user's viewpoint. You'll probably also get a few suggestions about how to do things
differently— these ideas may or may not turn out to better than yours, but any idea from a potential user is worth
considering!

You should also consider seeking opinions from the GNOME Usability team
[http://developer.gnome.org/projects/gup/]. They have designed many user interfaces before and may be able to spot
potential problems at this early stage, before you take your design too far to change easily.

Once you've decided on the basic interface design and have started coding parts of it, find somebody to try it out
again— it doesn't have to be the same person. You'll probably find some more problems that were hard to see on
your static paper prototype. By finding these now, it's usually not too late to fix them without too much trouble.

2.2. Internationalization and Localization

If you intend your application to be translated into different languages, show draft designs of your application to the
GNOME Translation Team [http://developer.gnome.org/projects/gtp/contact.html]. They'll help you find potential
translation problems, such as not leaving enough space for translated labels, shortcut keys that cause problems on a
different keyboard layout, or using new terms in your app that are hard to translate.

If possible, try out your application with users from the locales you are targeting. This will help you determine
whether users understand how to use the application, if they perceive the graphics and colors the way you intended,
and if there are words or images in the application that may cause offence to users of that locale.
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